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Overview

CallRecorder  is an easy to use VoIP call recording solution that implements the corporate call recording keeping policy and provides secure TM

and easy access to call records.
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Call recording is now an essential business function for all organizations for which phone calls and direct vocal communication mean a voice-
assumed contract and request liability and money protection, as well as damage control, better trained and staff retention. This is why RAI 
Software offers a complete solution, providing with:

Safety (business liability) - record and backup discussions, contacts and verbal contracts, orders and business processes of the 
institution, without any risk of losing specific details in verbal communication;
Customer satisfaction - monitor and improve interaction between customer and staff; register and solve possible complaints before they 
become "larger issues"; 
Improve staff quality - train, monitor and coordinate staff by training sales, communication and interaction skills;
CallReplay allows managers to review and score phone calls according to their work group, listen the conversation, discuss, analyze, 
train, take decisions; Users are empowered by providing them with accurate records of their calls.
Better quality operations and cost effective services - all details are centralized and recorded on an electronic file, no more lost details or 
info, wrong address deliveries, etc.

CallRecorder  integrates also Screen Recording tool, Memolith, allowing the recording of computer desktops, either linked to a phone call or TM

non-stop.

CallReplay is a self-contained software recorder which includes everything necessary to record VoIP calls (besides the Operating System and 
server hardware): database, web server, Java VM, etc.

It supports active recording for most major PBXs, having an XML phone service which allows replaying calls directly on the phone, and can be 
deployed in virtual machines (VMs). 

It works perfectly with Cisco & NEC & Mitel & IPTrade VoIP PBXs (no proprietary hardware required) and can scale up from 1 to 1,200 marked 
devices in a single box configuration.

CallReplay  is now at its 9th generation TM and we are proudly present on the international market (the United States, Asia, Europe) through a 
network of partners, distributors, Telecom integrators and direct customers.

Main Features and Benefits

Automatically Record Phone Calls - Damage control and increased accountability in your personnel, suppliers and customers.
Manual (On-Demand) Control: Recording can also be initiated by the user using the browser or IP Phone Service. Both Full Call and 
Partial Call recording modes are supported.
Multiple Recording Methods: CallRecorder supports both port mirroring (SPAN) and forked recording (SPANless). Hardware recording 
coming soon!
Monitor Live Calls: Listen to a call in progress, through the browser or IP phone service. You can also   to the agent without whisper
being heard by the external party (IP phone service).
Browse Recordings by Agent: Superb browsing interface tracks agents across multiple phone numbers.
Search by caller ids, phone numbers, annotations, time, description, tags, etc.
Replay, Annotate and e-Mail phone call recordings. Easy, secure access to call recordings, using a web audio player, desktop audio 
player or IP Phone Service.
Tagging & Searching calls with customized hierarchical tags has never been easier.
Call Scoring & Custom Forms: Integrated agent scoring and reporting module.
Agent Call Statistics Reports: The number of calls made, received, etc by each agent.
Email Notifications: Automatically send email when a predefined number appears in a call.
Backup & Restore: Archive calls on DVDs, HD-DVDs, BluRays or SANs. A single DVD can store up to 15,000 calls of 5 minutes each, 
due to the state-of-the-art voice compression technology incorporated in CallRecorder.
Reverse Caller Lookup: Displays the caller name and business unit using the company Phone Directory.
Multi Site Replication: Using queued replication, you can record many network partitions and centralize recordings at the HQ. 
Recording and replication survive a downed WAN link.
Screen Recording: Integration with Memolith Screen Recorder. See what was done on the screen while the phone call occurred.
Specialized Speech Compression lowers the storage requirements 8 times over MP3 and allows 18,000 hours of phone calls storage 
on one 120 GB hard drive.
Call History: Follow a call as it is transferred, put on hold or parked.
Audit Replays: Prevent recordings abuse by browsing the list of accesses to a call.
XML Phone Service: Handily review your past calls from your XML enabled phone (Cisco IP Phones 7940, 7960 & 7970). Authenticate, 
Browse, Play, Rewind, e-mail, mark important. You can also assign calls to folders.
Access Control Lists: Fine grained permission system to allow listening and acting on calls.
Automatic Software U
Try Before You Buy: Download a fully-featured evaluation version with a friendly configuration wizard from .www.call-replay.com

What's New

HTML5 interface

Please refer to  and  sections for more details.Specifications Requirements

http://call-replay.com


Opus Codec Support

Requirements

Hardware Requirements

Server

Virtual Machines: VMs are supported in all recording modes for up to 50 simultaneous calls. Forked Recording mode works directly, 
while SPAN recording requires additional configuration to enable network cards to work in promiscuous mode.
CPU: any modern quad core CPU will support 500 simultaneous calls, the limits are in the RAM and disk IO subsystems.
RAM: 1 GB of RAM for the system + 1GB for each million call records stored in the database. For example, if you intend to store 2 
million calls in the database, provision at least 3GB of RAM for the server.
Storage: audio compression rate of 1.7 KB/s means that each GB on the drive can keep about 160 hours of recordings (voice 
compression is 8 times better than MP3). That is, you can keep 96,000 calls of 10 minutes on one 100 GB HDD. One month of typical 
call center recordings (160,000 calls) takes about 55 GB.

Network

SPAN recording requires:

Managed network switch with port-mirroring capability (SPAN)
At least two network interface cards are required on the recording server, one for each monitored switch, and another for the site (a 
monitoring port can only receive packets). Using one interface card is possible, but the administration site will only be accessible from 
the physical console.

Forked recording requires:

One network interface card on the recording server, for administration site and recording
Cisco CallManager platforms newer than 5.0. For Cisco CallManager Express please use SPAN recording.
Selected Cisco phone models.

Software Requirements

Server Side

Operating System: Any Windows Server. Desktop Windows OSes (Professional, XP, Vista, 7, 10) can also be used, but TCP 
connection on these platforms are limited to 10 simultaneous sessions, limiting the number of users which can replay calls using the web 
site or a phone service.

Client Side

 Any operating system, with a browser for example Internet Explorer 6, Firefox 3.0 and Opera 11.x.Chrome

Specifications

Editions

There are two CallReplay  editions available:  and .TM Evaluation Production

Please refer to the Licensing >  chapter for more details.Licensing Pools

It is highly recommended to use redundant disks (RAID1 and above) only, for storing call recordings.

IMPORTANT: It is recommended not to run any other server software on a production recording server! Call recording is essentially 
real-time. Failing to keep up with the traffic can result in lost calls. Other software can unpredictably use critical processor and memory 
resources which are necessary for packet capture. The application allocates computing resources according to priorities so an 
uncontrolled processing spike of another program may disrupt recording.



The  edition is commercial and provides all the outstanding features packaged into an easy to install kit. The  edition is a 30 Production Evaluation
calendar days time limited version (or based on license granted), that contains all the benefits available for  edition.Production

You can find the latest versions of CallReplay  including the Evaluation edition on our website at  page.TM CallReplay Download

Technical Specification

VoIP PBX
Cisco CallManager (all versions)
CallManager Express
Avaya CM S8000 series and IP Office 500
NEC Univerge - SV8000 series, IP only
generic SIP
IPTrade turrets
Mitel

IP Phones
All Cisco IP Phones
All SIP phones

Operating System
Any Windows OS 64 bit

Hardware Requirements
Software only recording system, no proprietary cards
Industry-standard Intel compatible server supplied by customer
Network connection to voice traffic, using a hub or a mirrored port 
for promiscuous mode network sniffing

Recording Capacity
Up to 400 simultaneous calls on a single dual core CPU

Retention Capacity
Speech compression, VBR, Stereo, 170 hours per GB
~ 18,000 compressed talk hours on one 120GB HDD

Supported codecs
G.711 A-law and -law
G.722
G.729 (extra options: G.729A, G.729B, G.729AB)
Opus

Recording Architecture
Passive network sniffer, Skinny Protocol
SIP trunk recorder compatible with newer Cisco phones
Stereo, each party is heard in a different channel

Embedded Database PostgreSQL 12

Security
Secure access to recordings
Managers have access to calls based on logical departments 
filters

Call records access
Web interface + desktop player
Phone Service interface (on Cisco IP Phones 7940, 7960, 7970)

Support

If you want an evaluation license, you can request it via email from   or  .info@call-replay.com http://call-replay.com/go/contact

http://call-replay.com/downloads
mailto:info@call-replay.com
http://call-replay.com/go/contact


1.  
2.  
3.  

1.  
2.  

Technical Support includes Software Upgrades
TeamViewer software included

Install And Setup On Windows

Installing on Windows
Upgrading CUCM
Migrate To A New Server
Upgrade CallReplay

Installing on Windows

You can download the latest version of CallReplay  from the  website. Earlier versions of CallReplay can be found at the TM CallReplay Download
same location.

To install CallReplay v.10 you need to download and run CallReplaySetup10.0.0.xx.exe

Install CallReplayTM

The installation is straight forward and the package contains everything is required by the system to run without any further intervention. Just 
follow the screens.

Welcome Screen

Check if the setup version you are running is the latest available from our web site.
Launch the setup executable
Select a language and OK

License Agreement

Click "I Accept" if you agree with our license. You may not use the software if you do not agree.
Click Next

Please refer to  and  sections before launching the installation kit.Specifications Requirements

Make sure you have read the  chapter before proceeding further.  Requirements

http://call-replay.com/downloads
https://docs.call-replay.com/pages/createpage.action?spaceKey=OLD&title=Specifications
https://docs.call-replay.com/pages/createpage.action?spaceKey=OLD&title=Requirements
https://docs.call-replay.com/pages/createpage.action?spaceKey=OLD&title=Requirements
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 Destination Folder

Select the destination folder for the application binaries (calls are stored separately);
Click Next.

Data folder for storing call recordings and database files



This is the folder where all the user data, including audio files, the database, logs and licenses will be stored. Please select the disk with the 
maximum available free space. Use a RAID protected disk for this folder.

 

Site Configuration

At the end of the setup, the Site configuration application will launch the PreConfiguration web page to assist configuring of the name, IP and port 
of the administration web site. You may use port 80 if it is not used by another web server.
The IP of the website is also used for licensing purposes.
Press OK to start the administration web site.
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Database Setup

This page appears only if the database does not already exists in the data folder. You have two options:

If this is a fresh installation (not an upgrade), the left-side panel should be used. Enter the administration account and password for the 
new database, then click the Create Database button.

 



Login page

 Enter the user name and password. When running with an evaluation license, this page always displays the name of an administrator and a 
public password "eval" which works for every user.
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Draft

You can download the latest version of CallReplay  from the  website. Earlier versions of CallReplay can be found at the TM CallReplay Download
same location.

To install CallReplay v.10 you need to download and run CallReplaySetup10.0.0.xx.exe

Install CallReplayTM

The installation is straight forward and the package contains everything is required by the system to run without any further intervention. Just 
follow the screens.

Welcome Screen

Check if the setup version you are running is the latest available from our web site.
Launch the setup executable

Please refer to  and  sections before launching the installation kit.Specifications Requirements

http://call-replay.com/downloads
https://docs.call-replay.com/pages/createpage.action?spaceKey=OLD&title=Specifications
https://docs.call-replay.com/pages/createpage.action?spaceKey=OLD&title=Requirements
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Select a language and OK

License Agreement

Click "I Accept" if you agree with our license. You may not use the software if you do not agree.
Click Next

 Destination Folder

Select the destination folder for the application binaries (calls are stored separately);
Click Next.

Make sure you have read the  chapter before proceeding further.  Requirements

https://docs.call-replay.com/pages/createpage.action?spaceKey=OLD&title=Requirements


Data folder for storing call recordings and database files

This is the folder where all the user data, including audio files, the database, logs and licenses will be stored. Please select the disk with the 
maximum available free space. Use a RAID protected disk for this folder.

 

Site Configuration

At the end of the setup, the Site configuration application will launch the PreConfiguration web page to assist configuring of the name, IP and port 
of the administration web site. You may use port 80 if it is not used by another web server.
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The IP of the website is also used for licensing purposes.
Press OK to start the administration web site.

Database Setup

This page appears only if the database does not already exists in the data folder. You have two options:

If this is a fresh installation (not an upgrade), the left-side panel should be used. Enter the administration account and password for the 
new database, then click the Create Database button.

 



Login page

 Enter the user name and password. When running with an evaluation license, this page always displays the name of an administrator and a 
public password "eval" which works for every user.
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Upgrading CUCM

After upgrading CUCM to a newer version, follow these steps:

Update CUCM version (   page -> press   button on the upgraded PBX -> update  field )PBXs Edit PBX Version 
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        2. If forked recording is active on the upgraded CUCM, re-run the forked wizard by pressing the   button on the required PBX, from   pagPBXs
e grid view.

Migrate To A New Server

When you want to move your existing installation to a new server but preserve all data, please follow the steps:

I. Easiest Procedure

On the old server, shut down the CallReplay and CallReplayDb services and set their Startup Mode to Disabled.
Copy or move the CallReplay Data Folder (by default, C:\CallReplay) to the new server. The CallReplay Data Folder is configured once 
at installation time and contains the sub-folders Database, Calls, Licenses, Logs, etc.
Then run CallReplay Setup on the new server. When asked about the Data Folder to use, point it to the copied folder containing old data.
After setup completes, you should be able to see the old calls and play them.
Cleanup the old server. Do not start the old server again after the license was re-activated on new server.

Note: The Data Folder in Linux is the   directory./var/lib/callreplay/  
  

 Things to take into consideration after the migration:
  

 Forked PBX Reconfiguration
  
After the migration you may need to run the Forked PBX configuration again, and make sure that: 
  
* Under the  tab, make sure you modify the  field, and fill it with the IP of the new machine:Auth & Service Phone service Address (this)

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-08-Aug/active_recording_button.png


* Under the  tab, make sure you fill in again the  and the  fields (if they were reset):Recording Trunk Device Pool Security Profile

Different IPs for the Old Server and New Server
 
In case you migrated between machines with two different IPs, you may need to run the  again (from the Start CallReplay Site Configuration
menu), and make sure you update the  and  entries with the new values of the server.Site Host Name Site IP
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II. Minimum Downtime Procedure

Install and configure CallReplay on the new server. Verify that recording works.
Copy or move the CallReplay Calls folder to the new server, into a new folder. Exclude from copying/moving the sub-folder of current day.
On the old server, shut down the CallReplay and CallReplayDb services and set their Startup Mode to Disabled.
Copy/Move the Database folder to the new server, then copy/move the folder left un-copied at step 2.
On the new server, shut down the CallReplay and CallReplayDb services.
In the CallReplay Data Folder, move the Database and Calls folders to a backup folder.
Move in their place the Database and Calls folders copied at steps 2 and 4.
Start the CallReplay and CallReplayDb services.
Review recording configuration (it has the config from the old server) and verify functionality.
If necessary, Restore the Calls folder backed-up at step 6.
Cleanup the old server. Do not start the old server again after the license was re-activated on new server.

NOTE

For every migration procedure, both CallReplay server versions must be exactly the same.

Upgrade CallReplay

1. Upgrade CallReplay in Windows
 
This is a short guide which explains how to upgrade CallReplay to the most recent version. Please notice that you do not need to uninstall your 
current version of CallReplay, nor do you need to delete the calls history or logs which reside by default inside . You can perform a C:\CallReplay
full upgrade and keep all your current settings and logs at the same time.
 
Compatible Windows Versions
 
CallReplay is known to run on Windows versions starting with, and including, Windows XP. However, for the server, the recommended Windows 
Server version is 2012.
 

Method #1: Upgrade CallReplay in Windows Manually
 
You can use this method to upgrade CallReplay or to install CallReplay freshly, on a system on which it wasn't installed before. In the second 
case, just skip the first step below. Follow the next few steps:
 
Step 1. Stop the associated Windows services
First, stop the following Windows services, which belong to the CallReplay platform:  and . An example CallReplay Call Recorder CallReplayDB
is shown in the image below:



 In the case that the CallReplay Call Recorder service doesn't stop, you may need to hit Alt+Ctrl+Del, start the Task Manager and end the task 
CallRecorder.exe before you stop the services.
 
2. Download the CallReplay installer
The CallReplay setup program is an executable file. You can download the latest version from . Save it somewhere on the hard-disk.here

3. Run the CallReplay setup program
Note: Before performing this step, make sure you are logged in as a Local Account Administrator and any antivirus software is disabled.
 
Now you need to run the installer, which may be called something like CallReplaySetup9.10.0.28x64.exe. You can do so clicking on it in the web 
browser downloads window or by opening the file manager, going to where the setup installer was saved (usually Downloads) and after 
that double-clicking the executable setup program.

http://call-replay.com/downloads


4. Let the setup wizard follow its course
The installer is automated, and you will need only to press  throughout the wizard until the installation is complete.Next



You should leave the values from the  window untouched, and then press :Site Configuration OK



5. Finishing the installation
Once CallReplay finishes the configuration, it will open a web browser to allow you to login. If you are installing for the first time, you will need to 
pick an administrator username and a password. If you are upgrading, you can proceed and login with the existing account credentials.
 
 
6. Run the Forked wizard again
If CallReplay is using Forked recording, after the upgrade it may be needed to run the Forked wizard (Active recording button on the PBX) again, 
manually going through each tab starting with the second one ( ), using instructions from .Auth & Service here
 
 

Method #2: Installing CallReplay in Windows Using the CallReplay Software Update Utility
 

 Please notice that this method can only be used for upgrading between minor versions (e.g. 8.0.140 to 8.0.151). For upgrading Important:
between major versions (e.g. 7.x to 8.x) you will need to use the manual method explained above.
 
For this you will use the CallReplay Software Update utility, which allows you to select a recent version and then installs it automatically.
 
1. Start the CallReplay Software Update utility
This tool is available in the Start menu, by typing  and clicking on the application that appears.callreplay software update
 
2. Select the desired version
In the Software Update tool, you can choose between the hotfix (the latest version) or the latest stable version. Make sure the   field Upgrade to:
is not empty and then click the  button.Update

 

Getting Started

https://wiki2.raisoftware.ro/books/callreplay-v9-admin-guide/page/forked-recording
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Your User
User Interface
Dashboard

Your User

Login

To connect to the  web interface  you need to open the URL in a  (Shockwave Flash) enabled browser. If you do CallReplay Adobe Flash Player
not know the 's URL, please ask your administrator.CallReplay

To open the application just introduce your user name and password associated with it, then click .Login

Enter your user name
Introduce the password associated
Select language in which you like to see the application

If you forgot your user name or password, contact the system administrator

How-to and Troubleshoot

Check  page to see how you install Adobe Flash Player.Install and Activate Adobe Flash Player

User Interface

The user interface is divided between the menu area and the working area.

The menu are consists of a menu with drop-down lists, linking to all the pages in CallReplay and immediately below, a ribbon with shortcuts to the 
most important and commonly-used pages.

Immediately below is the working area, which displays the pages. Some pages will divide this area further into 2 zones, with a left tab showing 
the categories tree and the right one showing the different configuration options for the selected item.

You can resize the interface and font size by holding the Ctrl key and using your scroll wheel.

Dashboard

https://wiki2.raisoftware.ro/books/cr-user-guide-draft/page/install-and-activate-adobe-flash-player


Starting with v.9 CallReplay  provides a customizable Dashboard not only that displays various useful and real time statistics or configuration TM

settings, but provides the flexibility to remove or add predefined widgets that fits with your needs.

In order to acces CallReplay  Dashboard you need to click on   availble on the toolbar.TM

Unified Configuration

Configuration Overview
Global Settings
Style
User
Filters
E-mail Notifications
Permissions
Retention Policy
Cryptography
Recording Policy
Category Tree
Tags and Customers
General Tab
Classifier
Roles
Phone Directory
Email Configuration
Configure Port Usage

Configuration Overview

CallReplay v9 uses a new, hierarchical system of adding new users and roles, with the possibility to configure all the settings related to these 
users in a new,  panel.Unified Configuration

This system allows inheritance for permissions and recording policies, with the ability to edit settings on a per-user basis, grouping of users by 
folders and management of tags and customers.

This chapter covers the available settings in the  module, available from the  menu.Unified Configuration System | Configuration

Global Settings

Tags represent an additional method to classify calls and to give special attributes to selected calls. By using the filters, you determine which calls 
are assigned to a tag, irrespective of any other category they may be assigned to (another tag, or user).

By setting the recording policy you may alter the recording behaviour of a certain call to a user (for example recording all calls from specific 
external numbers, irrespective of the policy that may otherwise apply).

Setting up the Email Notifications enables you to send emails when such a call starts and ends, so you can, for example make sure e-mails are 
sent to the appropriate persons when important calls are being made, irrespecrive of the usual settings.

Calls assigned to such a tag can also have different retention policy settings.

Style

Withing the 'categories' tree can have different appearance depending on needs, but also to distinguish more easily between different nodes.

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-10-Oct/Screenshot-from-2016-10-05-15-43-37.png
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To configure style:

Go to .System | Configuration
Select the node to which you want to customize.
Click .
Select  tab.Style

Inside Style tab you can:

1. Change the foreground and background using color selector.

2. Change icon associated with that node by selecting an icon from the available icon list. You get access to the icon list by clicking on .

At any time you can revert to the default values by clicking on .

Changing a style will change the appearance of the respective item in the Category Tree as illustrated below.

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-10-Oct/Screenshot-from-2016-10-11-09-38-39.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-10-Oct/Screenshot-from-2016-10-11-09-47-19.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-10-Oct/Screenshot-from-2016-10-11-09-48-20.png
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User

This particular tab is available only in the context of user categories and allows you to define or change the information for a particular user that is 
granted with access to CallReplay.

The user defined here will be granted with DB Authentication. For other type of authentication please refer to the   sAuthentication
ection.

To create a new user:

Go to .System | Configuration
Select a node below user category, depending on the type of user you want to create. For example if you want to create a new agent, 
select  node, click  and select  menu.Agent Add User
Go to User tab and enter the information required
Click Save

https://wiki2.raisoftware.ro/books/cr-user-guide-draft/page/authentication
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-10-Oct/Screenshot-from-2016-10-11-10-26-52.png
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User ID: user identifier that is used during login
Name: A name associated with the user.
Email: valid e-mail address for the user.
Password: password that will be associated with the user and used during login
Confirm Password: password confirmation
PIN: personal identification number used to authenticate user during calls
Confirm PIN: PIN confirmation

To edit and existing user:

Go to .System | Configuration
Select the user you want to edit
Select User tab
Start editing the information you want to change
Click once you've done, click .Save

At any time you can send account information to the user who will receive and email as the one illustrated below.

Welcome to the CallReplay Call Recorder

Your new account information:

 URL: http://10.1.0.246:80/CallRecorder
 User: ioan
 Password: 9325a9960ce1706b49874e875ecfcd4f
 PIN: 9996535e07258a7bbfd8b132435c5962
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Filters

CallReplay can associate call or video records with a specific item category (e.g. a user, customer, tag or computer) by matching these elements 
using filters that you can create.

To create a filter:

Go to .System | Configuration
Select the item category on which the filter aplies.
Click .Edit
Select  tab.Filters
Click .Add

To delete a filter:

Mark the filter line you want to delete using the check box.
Click .Delete
Click , in the Confirmation dialog.Yes

You can define multiple filters in order to reach complex matching criteria

The " " field will compare the either the source, destination or both against the filterWho
The "Field" contains the elements that can be filtered:

Number - the extension/telephone number of a party
Name - the name of a party, as defined in CUCM
MAC - the MAC address of a party
IPAddress - the ip address of a party
Description - the call description, which is filled in the call details menu
Duration - the duration of a call, in miliseconds
Date - the date of a call
Suid - the user ID of a party, in an IP Trade call

The "Not" checkbox will negate the result of the filter
The "Comparison" field enables you to make different types of matchings to the declared value:

Equals - values have to match
Starts with - the declared value must be found in the begining of the compared value
Ends with - the declared value must be found in the end of the compared value
Less - the declared value must be lower than the compared value
Greater - the declared value must be greater than the compared value
Between - the compared value must be between the two declared values
In - the declared value must be found in the body of the compared value
Contains - the declared value must be found in the body of the compared value
Is Empty - the compared value mst be empty
Wildcard(*) - enable use of wildcards (use _ (underline) to match one character, and % (percent) to match multiple characters)
RegEx - enable use of regular expressions

The "Value" field is the value that will be compared to the selected type of element

E-mail Notifications

In the Email Notifications tab you can add addresses to which emails will be dispatched as soon as calls matching the respective user are 
recorded by the system.



You can add multiple e-mail addresses here, where the E-mail Notifications for this user will be sent 

In order for this to work the SMTP need to be configured. Please refer to E-mail Configuration sections for more details on how 
to configure SMTP.

Two e-mails will be sent, one at the start of a call and one at the end of the call. They include the call details, as well as a link to the respective 
call, in the CallRecorder interface. Note: the recipient will have to login with a user that has replay permissions for that call, in order to access the 
URL.

 

 

 

Permissions

Newly created users and folders will inherit permissions from their parents. Permissions can be modified however on a per-user basis. Changing 
a folder's permissions will change the permissions of all children that inherit those permissions.
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When a permission is inherited, the inherited value and the node it is inherited from will be shown between brackets. It is possible to change any 
permission, as long as you have the right for that permission yourself. Permission changes will also inherit down the inheritance line, so changing 
any permission will change it for all it's inheritants. 

This feature is available only for items of user type

To configure permissions:

Go to .System | Configuration
Select the user for which you want to change permissions.
Click on  tab.Permissions

Replay Calls - allow or deny access to replaying calls  (allow setting will show name tags on the right, clicking on them will edit the users 
or folders for which the recorded calls can be played)
Is Admin - grants an administrator the rights to change settings within the tenant he is a member of
Replay All Calls - gives permissions to replay all calls, irrespective of the selection made at "Replay calls"
Delete Calls - gives permission to delete calll recordings from CallReplay
Edit Tags - grants the permisson to edit tags
Super Admin - grants super administrator rights to a user, allowing to create tenants and change global settings, tenent-independent
Assign Customers To Calls - grants permission to assign existing customers to calls and to create new customers as well
Login and Replay Own Calls - grants the permissions to log in the web interface and replay calls
Export - grants the permission to export any call that can be replayed
Audit - grants access to the audit page
Assign Tags to Calls - grants the permisson to add tags to calls
Stop Active Calls - grants the permission to stop the recording of an ongoing call
Do Not Record - obsolete
Edit Quality Standards - gives access to quality standards management (add and edit questionnaires)
Fill Questionnaires - grants permission to fill questionnaires on the recordings that are available
View Quality Reports - grants access to the Quality Reports menu
Create user - grants the permission to create new users, with the ability to edit the same permissions that are available for this user

Retention Policy

CallReplay can respond to various data retention requirements and can be configured in various ways in order to meet such requirements. By 
default, CallReplay keeps call records until there is no more storage available.

To set retention policy:

Go to .System | Configuration
Select item category for which you want to customize the retention policy.
Click on  tab.Retention Policy



Keep For Period - it will keep the user's recordings for the specified amount of time, then delete them
Keep Until Backup - it will keep the user's recordings untill they are backed up, then delete them
Keep until Space Required - will keep user recordings untill the set amount of disk space is reached. 

Cryptography

Cryptography allows the encryption of the recorded calls with the use of imported or self-generated certificates.

Before using this feature you need to have valid license that support encryption. Otherwize you will get

In order to enable records encryption, you must first add a certificate. Please open the Certificate Manager link. In the upper left of the 
Cryptographic Key Manager window you can choose wether to upload a certificate or generate a new one. 

For a new certificate you will need to provide a User ID and a private key passphrase - your certificate password.

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-10-Oct/Screenshot-from-2016-10-11-15-00-44.png


   After generating or uploading a certificate, close the window and select it for encryption. Next, select how you want the recordings decryption to 
be handled:

Automatic mode will decrypt the calls automatically when playing them from the CallReplay interface
Passphrase will ask for the certificate's passphrase when playing a call from the web interface
Disabled will not allow the recordings to be played from the web interface

Encrypt Existing Calls - you can choose if you want to encrypt existing calls with the new certificate, or just encrypt new calls

 

When playing a call, if Decryption mode is Passphrase, you will be asked for the passphrase of the certificate used to encrypt the call.



If the Decrtyption mode is Automatic, the call will be decrypted automatically and played.

If the Decrtyption mode is Disabled, You will be informed that you need to save the call as it is on your PC, then decrypt it locally using PGP.

Recording Policy



Recording policy has been integrated into the new unified configuration menu, so it is now possible to customize it for departments or even users. 
Inheritance works for recording policies as well. You may change the settings for a particular user, folder, or just go with the default policy:

 

 

The Call Recording Trigger determines if calls are recorded autoatically, on-demand or not at all
The Screen Recording Trigger determines if the associated Memolith client records all the time, durinng calls or not at all
Channel Pool subscribes the user to a Pool, please make sure enough channels are provisioned to the selected pool
On Demand Approval determines if the full call is recorded, or if the recording is done after the request
Enabling Record Unlicensed will register calls that do not match the recording policy, but they will have no audio recording available
Incoming, Outgoing or Internal recording determines if a call is recorded, based on the direction of the call

For proper call direction determination, you need to set the External PBX Trunks in the PBX configuration interface. For details, 
please consult the CallManagers (PBXs) Configuration page

Recording Parked and Transferred calls will keep recording such a call regardles of the next leg's policy
Remove Empty will delete all recordings with no associated audio data
Lookup Party Name will get the CallerID value from the PSTN and associate it

Category Tree

Users and departments are managed in a category tree which allows inheritance for permissions and recording policies. On a clean installation, 
the Category Tree will be similar to the structure shown in the screenshot below:

System > Configuration



 

The top search field allows you to quickly search and display only the objects matched by the search criteria.

By default, a pre-defined, logical structure is available, defining several folders and the admin username. Each child entry will inherit by default 
from its parent, however, any option can be overriden by specifically changing its value from Inherit to something else in the respective Recording 
Policy or Permissions tab.

The categories may contain three types of objects: folders, users and tags.

The  is the root object of the tree, and has all its inheritable permissions set to a default. Any child who has an inherit permission Global Settings
(as opposed to an explicit permission set manually) will inherit that permission from its parent. Inheritance calculation goes up the tree until the 
first explicitly set permission is encountered. This permission will also be the one that eventual children will inherit.



The Global Settings folder acts as a logical fallback for added users or folders that will not have set their permissions explicitly.

The  special folder will get populated with computer hostnames that are added to Screen Recorder.Computers

The  folder contains all the customers that users create. Customers can be ussed to identify and classify calls, store basic customer Customers
info, as well as setting different policies for them.

The  folder, groups the various created tags.Tags are used to classify certain calls and can impar different policies to them, behaving simillar Tags
to Customer type categories.

 

Adding new entries

To add a new entry to the system, mouse-over the category under which you want to add the user and click on the icon that pops up, as shown in 
the below screenshot:

 

A menu allowing you to add a user, folder or tag will appear. Once you click the desired entry (User, Folder or Tag), the  will be Edit Mode
enabled, allowing you to fill in the details of the newly created entry:



Tags and Customers

The Tag and Customer category types can be used to classify calls for a better oranization of recordings, to set different policies to calls or to 
send notifications when certain calls are being made.

These 2 categories do not have the User and Permissions tab, which is what sepparates them from the user category. In addition, the Customers 
category has a Customer tab which contains the customer data.

 

Customer ID
Name - the name of the customer
Email - the email address of the customer
Address - the physical address of the customer
Website - whe websire address of the customer

All other tabs serve the same functions as in the User category.

General Tab



The General tab allows you to set the name and description of a node, as well as select which nodes are its parents.

   Menu > Configuration > Edit

Classifier

The classifier is a back-end mechanism that looks at a call's properties and then compairs them against each category's filters.

When a call starts and when it ends, the classifier compares the call against all the filters and assigns that call to one or more categories. This 
means that at the call's start, the classification will determine wether the call is recorded or not and other properties, depending on the category 
that receives ownership of the call. At the call's end the duration might get compared against existing filters which might assign the call to even 
more categories.

The classifier is also invoked whenever a new filter is added, or an existing one is modified, checking all existing calls against the new filter.



Status shows the status and speed of the classifier
Smart classifier is the default option, disabling it turns the classifier into a "safe mode" classifier - do not change unless explicitly 
instructed by CallReplay support staff
Thread count: sets the number of threads the classifier will use. Lowering the value will make the classifier work slower, but will decrease 
CPU load. This should be set accordingly to your CPU resources and third-party CPU load.
Chunk size: the number of calls it processes at a time - do not change unless explicitly instructed by CallReplay support staff
Priority: sets the priority of the classifier against other CallReplay functions - do not change unless explicitly instructed by CallReplay 
support staff

Roles

Roles are collections of permissions similar to Windows user groups.
The application has 3 built-in roles: Administrators Group, Supervisors Group and Agents Group.

Administrators can configure the application which includes adding other users, 
upgrading it or configure system-wide settings 
may take any action on any call

Supervisors can replay his own calls and the calls in al the departments and their 
sub-departmentes.

Agents can only access his own calls

An administrator can also configure the application so that a manager can only replay calls, with the exception that a manager can view all calls 
within the filter set.
The administrator account settings are made in application web site.



Phone Directory

Phone Directory

This feature allows to identify the caller and destination phone numbers of a call when caller ID is not available. You can organize your contacts 
hierarchically on organizations and sub-departments by clicking on  .System / Phone Directory
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Adding External Organization / Department

Press Add button and choose Add Directory for adding new directory.

Adding a new external contact

Press Add button and choose Add User for adding new contact. Each contact can have one or more phones
After adding an external contact, each call with that contact will have it colored in blue, with a tool-tip when hovering the cursor over the contact 
name.

 

Email Configuration

Enter your SMTP server credentials (SMTP server, Authentication User, password).
The Admin Email Password is also used for critical alerts.
Click Save.



System > E-mail 

 
Below is an explanation for each field:
 

SMTP Server: The IP or FQDN of your SMTP Server.

SMTP Port: 25 is standard.

TLS: Most people do not use TLS security. This should be left unchecked.



POP3 Server: If the Mail server leverages POP3, input the IP or FQDN. Most people do not use this, so it may be left unchecked.

Authentication User/Password: If the Mail server requires credentials, input the User/Pass.

From E-Mail Address: When low level emails, like exporting a call, the From Address will be used as the From address in the email.

Admin E-mail Address: When System Level emails need to be transmitted to the Call Replay admin, the Admin email address will be who 
receives those emails.

System level emails may include:

* Running low on storage.

* Calls have not been recorded for X days.

Configure Port Usage

In the  page you can configure which ports the application will use. Please modify the ports only for specific purposes System > TCP / UDP Ports
and note the original settings before changing them. A reference list can be found in the screenshot below.

System > TCP / UDP Ports

Incoming Ports

Monitoring Port: The port used to monitor (listen) to active calls. (Editable)
Flash Policy Port: (Editable)
Jdbc Port: The port by Jdbc to communicate with the PostgreSQL server. This is actual port on which the CallReplay DB service is 
listening for incoming connections. (Read-Only)
Web Server Port: The port used to access the CallReplay web interface (via a web browser). (Read-Only)
Web Server HTTPS Port: The port used to access the CallReplay web interface over SSL (used only if SSL is enabled from System > 
HTTPS). (Read-Only)
RTP Port Range: The range of ports used to record calls (the ports used by the phones to send audio RTP packets to CallReplay). (Edit
able)
Transcoder Port: The port used by the Transcoder. (Editable)
Tracing Port: (Editable)

Outgoing Ports



Licensing Branch Port: The port used to replicate calls from the branch to the headquarters. (Editable)
Ldap Port: The port used for LDAP communication. (Editable)
Email Smtp Port: The port used by the SMTP port. (Editable)
External Signalling Listener Port:  (Editable)
Phone Rtp Rx Port: (Editable)
Phone Whispering Port: The port used to whisper to a phone. (Editable)
Mitel Tunnel Server Port: (Editable)
Mitel Def Remote Port: (Editable)

Licensing

License Management
Licensing Pools
Branch Licensing

License Management

Overview

Before using CallRecorder you need a valid license. Depending on your specific needs, RAI Software can provide the following licenses:

Ultimate
Evaluation
Replication
Codecs

Please contact us by sendig an e-mail at   or check our contact page at  .info@call-replay.com http://call-replay.com/go/contact

There are two kinds of license files: 

.lix is a generic license, not-activated or bound to any computer.

.bind is an activated license file which only works on the computer where it was activated. Only production licenses need to be activated.

User Agreement Violations

Loading the same license file (that is, with the same license ID) on two servers at the same time.
Using the license file after it has been revoked or superseded by a newer license file.

Add License

To add a new software license file, select  from the menu then click the  button. The license fill will be System | Licenses Upload
automatically activated if necessary and stored in the DataFolder/Licenses directory.

mailto:info@call-replay.com
http://call-replay.com/go/contact




If you have troubles with licencing CallReplay, please contact our web site for license verification, please open the Manual 
Activation link ( ) on a computer with Internet access and fill in the requested http://lix.call-replay.com/Lix/ManualActivation/
information.

Company Wide Recording (CWR) License

If you have a Company Wide license type, ensure that application can contact CallManager to establish the number of registered phones.

This licensing model is obsolete, do not configure it unless instructed by technical support.

You must supply a user name and a password in the “ ” tab, which is used for authentication with the CallManagers.Company Wide Recording
This user must be the same on all the specified CallManagers. The password must be the same on all the specified CallManagers. You don't
need to specify the password each time that you make an update in the configuration page, but only when you need to change the existing
password.

System | Licensing | License

Branch Licensing

You may use the same license to run multiple CallReplay sites, by splitting the available channels between them.

You will need to configure the server that has the license activated as the HQ licensing server:

enable "Act as HQ Licensing Server"
make sure the "HQ Address" is correct and reachable by the branches
set a password for the branch connection
make sure that the branch is enabled once it is connected and appears in the list
edit a branch to set the number of channels allocated to it

 In order to configure branch licensing, please go to .System > Licensing > HQ/Branch Licensing

http://lix.call-replay.com/Lix/ManualActivation/


The  other servers must be set up as licensed branches:

go to the Branch tab and check the "Act as Licensed Branch"
enter the HQ address and port
enter the connection password
click save 

Licensing Pools

Channel allocation is now achieved through the Licensing Pools page. You can allocate channels to each type of recording here, to suit your 
specific recording requirements.

The order tab adds a weight, so that if a user has 2 different recording policies, (a user may reside in 2 departments, for example) it will 
select the policy with the highest weight.
All recording policies have their name, quality of service and description displayed here.
Active Voice Channels / Screen Recorders show the current usage in the respective channel
Voice subscriptions are the total amount of users that have the respective recording policy. Note: If the number of subscriptions exceed 
the number of provisioned channels for reserved recording, the configuration will become invalid. You will have to provision more 
channels to meet the QOS.
Provisioned channels represents the number of channels you allocated to the respective recording policy.

  System > Licensing > Licensing Pools

Editing a pool allows you to change its properties and allocate recording channels.



The name will allow you to identify the pool both in the Licensing Pools page and in Recording Policy, when assigning a user to a pool.
You can use the description to add more info about a pool
The Screen Recorders and Channels boxes are set with the number of resources provisioned for the pool
Reserved Quality of Service enforces provisioning of resources, so that there must always be at least as many channels provisioned as 
there are subscribers. This means that all calls that are assigned to this channel pool will always have an available channel for recording.
Best Effort Quality of Service, or dynamic mode allows more subscriptions than provisioned channels. When the provisioned resources 
are used, subsequent calls will not be recorded untill a channel is freed.
The Order is used in the case of a call that may ba assigned to different categories, having different Licensing pools settings. The values 
of the different "Order" will be compared, and the pool with the highest order will be assigned for the call.

Please note that for setting Automatic or on-demand recording, you must set the Recording trigger in the Recording Policy tab, in the 
Configuration window. The difference between Automatic and OnDemand pools is only for backward compatibility.

Branch Licensing

You may use the same license to run multiple CallReplay sites, by splitting the available channels between them.



In order to configure branch licensing, please go to .System -> Licensing -> HQ/Branch Licensing

You will need to configure the server that has the license activated as the HQ licensing server:

Enable "Act as HQ Licensing Server"
Make sure the "HQ Address" is correct and reachable by the branches
Set a password for the branch connection
Make sure that the branch is enabled once it is connected and appears in the list
Edit a branch to set the number of channels allocated to it

 System > Licensing > license HQ / Branch Licensing

The  other servers must be set up as Licensed Branches:

Go to the Branch tab and check the "Act as Licensed Branch"
Enter the HQ address and port
Enter the connection password
Click Save

System

Watchdog Configuration
E-mail Configuration
IP Phone Service
HQ/Branch Replication
Software Update
Tenants
Secure Communication
Certificates
Authentication
TCP/UDP Ports
CDR Verifier

Watchdog Configuration

Watchdog is a monitoring component that tracks - at each 60 seconds - the CallRecorder service performance and trigers recovery actions, 
including service restart, and automatic notification in case of impeding errors. In addition, watchdog can be scheduled to perform automatic 
service restarts, or to send email notification when no recording are made within a specified period of time.



Out Of Memory threshold should not be changed without express instructions from CallReplay support staff.

Configure

Watchdog configuration page can be accessed through  menu.System > Watchdog

Total Memory: Total memory allocated for CallRecorder service.

Current Memory Usage: Currently memory used by the CallRecorder service.

Out of Memory Threshold: If threshold is reached a restart is initiated regardless scheduling 
stettings.

Restart Scheduling

Watchdog can be scheduled to initiate a service restart at a specific hour and at a specific day of week, or daily.

Watchdog is a monitoring component that tracks - at each 60 seconds - the CallRecorder service performance and trigers recovery actions, 
including service restart, and automatic notification in case of impeding errors. In addition, watchdog can be scheduled to perform automatic 
service restarts, or to send email notification when no recording are made within a specified period of time.

Out Of Memory threshold should not be changed without express instructions from CallReplay support staff.

E-mail Notifications

Watchdog can be configured to send e-mail notification in case when no recording are made within a specified number of calendar or business 
days.

Please check E-mail Configuration page for details about how to configure it.



E-mail Configuration

CallReplay can be configured to send e-mail notification whenever alerts are available, including

Running low on storage
Call have not being recorded for sevaral days

In order to configure the e-mail notification go to the menu and select .System | E-mail

Where:

SMTP Server: The IP or FQDN of your SMTP Server.
SMTP Port: 25 is standard.
TLS: Most people do not use TLS security. This should be left unchecked.
POP3 Server: If the Mail server leverages POP3, input the IP or FQDN. Most people do not use this, so it may be left unchecked.
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Authentication User/Password: If the Mail server requires credentials, input the User/Pass.
From E-Mail Address: When low level emails, like exporting a call, the From Address will be used as the From address in the email.
Admin E-mail Address: When System Level emails need to be transmitted to the Call Replay admin, the Admin email address will be 
who receives those emails.

System level emails may include:

Running low on storage.
Calls have not been recorded for X days.

IP Phone Service

Manual Phone Service Configuration

(This chapter has been obsoleted by the Configure Cisco CM wizard in version 6). Please use the   Wizard in the Capture / Forked Recording
PBXs page.

Observation: Instructions for setting up a Cisco CallManager Express phone service can be found on Cisco's site:

http://www.cisco.com/en/US/docs/voice_ip_comm/cucme/srnd/design/guide/external.html#wp1074400

The IP phone service is a component of our application that allows users with a primary extension to listen to their calls from their Cisco Phone or 
to demand recording of calls. 
By accessing the   menu, you can specify the authentication parameters used with the Cisco Phone XML, and other values System/Watchdog
that affect the way that the service works:

Cisco User - The user name used for authentication with the Cisco Phone XML.
Cisco Password - The password used for authentication with the Cisco Phone XML.You don't need to specify the password each time 
that you make an update in the configuration page, but only when you need to change the existing password.

 System > IP Phone Service

Application Phone XML User

This user is required for the application phone services to function properly. There is only one application Phone XML User, and it is different 
from the site users. You may choose any user you want, but we recommend creating a new special user that nobody else uses.

Create a new Cisco User or select an existing one

Go to the CallManager Administration Site
Go to User/Global Directory
Click "Add a New User".For more details about adding a new user, please consult the CallManager Help.

Associate all devices with the desired user

   Make sure that this user has all the devices associated to him.
Go to the CallManager Administration Site

 Go to User/Global Directory, then click "Search"
Select or create the user you want to use with Cisco Phone XML. For example "CallRecorder"
In the User Configuration page, please click "Device Association"
Now you have to associate all the phones through which you want to access the application and/or Call Monitoring phone services with 
this user. If you want to associate all devices, do the following:
Press "Select Devices" ( leaving the search field empty )
Select "Check All in Search"
Click "Update Selected".

 

Setting up the authentication

 Go to System/IP Phone Service
In the "IP Phone Service" page enter the following values:
In the "Cisco User" field, enter the name of the user that you associated all your phones with (see the previous step)
In the "Cisco Password" field enter the password of that user
Press "Save"

To make the application service accessible on your Cisco IP phones, you have to go through the following steps:

 

Add a new service

Go to CallManager Adminitsration / Device / Device Settings / Phones Services

http://10.1.0.10:8080/wiki/display/CallReplayManual/12.1.+Forked+Recording
http://www.cisco.com/en/US/docs/voice_ip_comm/cucme/srnd/design/guide/external.html#wp1074400
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Press "Add New" button
Set "Service Name" to Call Recorder
Service Category must be   and Service TypeXML Service  Standard IP Phone Service
Set "Service URL" to http://CallRecorderServer(:port)/CallRecorder/phoneService
Click Save
For Demand recording the URL is http://CallRecorderServer(:port)/CallRecorder/phoneService/onDemandPhoneDemandThisCall

Assign the service to the phones you want

For large number of phones this is best done using Device Profiles.
Using the Call Manager Administration site:

Go to the CallManager Admin/Device/Phone
For each phone having access to CallRecorder, do the following:
Go to that phone's configuration page
Click "Subscribe/Unsubscribe Services"
In the available services list select CallRecorder, then click "Continue"
Click "Subscribe"
Click "Update"
Restart the phones so that they can read the new configuration (only if you had to change the URL to the value we specified)

Go to CallManager Admin/Device/Phone

 

For each page "Select all", click "Reset", then "Restart".

HQ/Branch Replication

This feature allows copying or moving calls to another computer for various purposes: safety, centralized management, high availability recording 
etc.

First, you need to configure the Headquarter (HQ) to accept incoming connections. For this, check 'Act as HQ Controller', then enter a password 
for connection and hit 'Save' button. Please note down the 'HQ Address' value, you will need it to configure branches.

In case you have multiple branches recording the same calls for high availability recording, please check 'High Availability' if you want to have 
distinct calls. However, you will have both audio files if recordings were replicated with audio.

To use this feature you need to have all branches and HQ clocks in sync. You may need to use the OS's time synchronization 
feature to a time server.

To open replication panel go to  menu.System | HQ/Branch Replication

To configure one other computer as Branch, you need to go to the 'Branch' tab:

http://callrecorderserver%28port%29/
http://callrecorderserver%28port%29/


You can replicate calls to multiple Headquarters. First click 'Add HQ' then enter the Headquarter address and port (the one you previously noted 
down). Also, enter the password you've set on headquarter computer.

After this, you will be asked if you want to replicate all existing calls or only the calls made from now on.

If the connection is working, you should see on headquarter that a new entry has been added (after clicking 'Refresh') for the newly configured 
branch.

You may now configure the incoming replication type. Call information only can be used for centralized management. These calls can be played 
back only when the branch is running. If replication is done with audio files, you can playback them directly from the headquarter. In this case, 
you can also choose to delete the successfully replicated call from branch.



Software Update

Software update page, availble from , displays information about your current installed version, application System | Software Update
update availability and subscribers status (see for details).

In addition, here you can configure how  should check for software updates availability and apply those updates.CallReplay Software Update 

Based on your specific needs you can specify if (i.e. 'Never') or how often CallReplay Software Update component should check for updates.

CallReplay Software Update

CallReplay Software Update is a separate component that give you the possibility to check for software updates availability and apply thos 
updates for your server or subscribed branches.

You can access CallReply Software Update from .Start | Programs | CallReplay | CallReplay Software Update

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-10-Oct/Screenshot-from-2016-10-10-12-39-06.png


Depending on you Microsoft Windows version, the system might ask you to provide elevated permissions for SoftwareUpdate.exe program. Click 
, or change teh  settings in order to run the program.Yes User Account Control

 

 

Tenants



CallReplay supports the concept of multitenancy by which an instance of CallReplay can serve different groups of users providing access with 
specific privileges, or structured in different ways. For example there might be a business branch and its users that can use CallReplay in an 
isolated way.

Additional tenants may be added hereby clicking the Add Tenant button. You will need to provision the desired number of channels and screen 
recorders, as well as the company's name TLD and number of branches.

Please note that when you upgrade your license with additional channels/recorders, you will need to assign them here, to the desired tenant.

System > Tenants.

Company - please enter the company name here, it will be used to identify the tenant
Please enter the company's top level domain, such as  in the TLD fieldguest-company.com
Active checkbox enables or disables the tenant
Branches field represents the number of branch replication channels assigned to this tenant
You must set the desired number of channels you are granting the tenant in the channels field. Please note that those channels must not 
be assigned to any other tenannt, including the default one. If all channels are assigned, you will have to revoke some and then check 
the respective Licensing Pools allocations.
Mobile phones - 
Screen Recorders - add the number of desired Screen Recorder channels for the tenant. As with the recording channels, they will need 
to be unassigned.
Storage Quota - you can set a storage quota for this tenant. 
Validity - an expiration date can be set for the tenant.
Stored Calls will show the number of stored calls for the tenant.

Secure Communication

By default, the CallReplay web interface can be accessed via plain HTTP, however SSL can be enabled from the  menu. This System | HTTPS
will allow users to log in to CallReplay securely over a HTTPS connection.

The administrator can generate a new certificate or use an existing one. 

http://guest-company.com


As mentioned, CallReply can work with plain or secured HTTP protocol and this behaviour is established by selecting " " for HTTP or "Plain text Se
" for HTTPS.cure

See also s.System | Certificate

Generate a Self-Signed Certificate

  
This can be accomplished by following the steps shown in the screenshots below: 
  
1. Choose "Secure" as the Connection Type:

 System > HTTPS

 
 
2. Press Finish once the "Generate Self-Signed Certificate" radio button is checked:
 

 
 
3. Restart the service:
 

 
Import a PFX/P12 Certificate
 
1. Select "Import Certificate":
 

 
 
2. Click on "Browse" and select the pfx/p12 certificate from the popup browser. You may need to enter a password for the certificate as well:
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3. Click Next and then Finish. Once done restart the service:
 

Certificates

Authentication

CallReplay supports two authentication modes: DB and AD/LDAP.

DB Authentication is the default authentication mode and is integrated at the application level. This means that the user name and 
password pairs are maintained at database level
AD/LDAP Authentication can be configured and is the authentication mode that is integrated at operating system level via AD (Active 
Directory) or LDAP (Lightweigth Directory Access Protocol)

For  to work, you need an Active Directory or other LDAP compatible service available.AD/LDAP Authentication

To configure AD/LDAP authentication mode:

Go to menu .System | LDAP Authentication
Select .AD/LDAP Authentication Mode
Provide the name of the AD/LDAP server
Enter the port where AD/LDAP is listening (389 is the default port for LDAP service)
Select the authentication method.
Enter the domain's name
Provide the user name as is defined within AD/LDAP
Provide the password associated as recorded by AD/LDAP

" " button becomes active only if a connection test was performed successfullySave

To configure DB Authentication mode:

Go to menu .System | LDAP Authentication
Select DB . Authentication Mode



TCP/UDP Ports

In the  page you can configure which ports the application will use. Please modify the ports only for specific purposes System > TCP / UDP Ports
and note the original settings before changing them. A reference list can be found in the screenshot below.

System > TCP / UDP Ports

Incoming Ports

Monitoring Port: The port used to monitor (listen) to active calls. (Editable)
Flash Policy Port: (Editable)
Jdbc Port: The port by Jdbc to communicate with the PostgreSQL server. This is actual port on which the CallReplay DB service is 
listening for incoming connections. (Read-Only)
Web Server Port: The port used to access the CallReplay web interface (via a web browser). (Read-Only)
Web Server HTTPS Port: The port used to access the CallReplay web interface over SSL (used only if SSL is enabled from System > 
HTTPS). (Read-Only)
RTP Port Range: The range of ports used to record calls (the ports used by the phones to send audio RTP packets to CallReplay). (Edit
able)
Transcoder Port: The port used by the Transcoder. (Editable)
Tracing Port: (Editable)

Outgoing Ports

Licensing Branch Port: The port used to replicate calls from the branch to the headquarters. (Editable)
Ldap Port: The port used for LDAP communication. (Editable)
Email Smtp Port: The port used by the SMTP port. (Editable)
External Signalling Listener Port:  (Editable)
Phone Rtp Rx Port: (Editable)
Phone Whispering Port: The port used to whisper to a phone. (Editable)
Mitel Tunnel Server Port: (Editable)
Mitel Def Remote Port: (Editable)

 

CDR Verifier

The CDR Verifier module is designed to fetch information from the CDR Analysis and Reporting information. The CDR Verifier is available from 
the  menu, but it first must be enabled in CallManager and on a per-PBX basis from  System > CDR Verifier Recording > CallManagers (PBXs)
in CallReplay.

Enable CDR in PBX

To enable the CDR Verifier in CallReplay, go to  and click  on a PBX line. Once the  window appears, switch to the PBXs Edit Edit PBX CDR 
 tab:Setup

CallReplay uses a built-in FTP server to which CallManager will upload its CDR information. Make sure to fill in all the fields:

Ftp Server Enabled: This must be checked so the built-in FTP server is active and listening.
FTP Server: This is automatically filled in by CallReplay with its IP address.
FTP Username: This will be the username used by CallManager to login to the FTP server. You can change this to a desired username, 
or leave it to default.
FTP Password: This will be the password used by CallManager to login to the FTP server. You can change this to a desired password, 
or leave it to default.
Directory Path: This is the path used by CallReplay to store the information received from CallManager (e.g. C:\CallReplay\Cdr\10.
1.0.30\).
Import Enabled: Check this to enable CDR imports.

Once the fields are filled in, click . One more step is required, and that is to enable CDR uploading in CallManager. Proceed to the next step to OK
do this.

Enable CDR in CallManager

In CallManager, go to , and make sure that under the  section, the  is set to :System > Service Parameters System CDR Enabled Flag True

Next, open the  from the top-right drop-down  entry. Now go to the  menu Cisco Unified Serviceability Navigation Tools > CDR Management
entry. Under the  section, click the  button:Billing Application Server Parameters Add New

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-08-Aug/sys_ports
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/pbx_cdr.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/ccm_enable_cdr01.png
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A new window where you can configure the FTP settings should appear:

Host Name / IP Address*: Enter the IP of CallRecorder.
User Name*: Enter a username to use when authenticating to the FTP server of CallRecorder (this will be configured later as well in 
CallReplay).
Password*: Choose a password to authenticate to the CallRecorder FTP server.
Protocol*: Choose FTP instead of SFTP.
Directory Path*: Enter a path in the form . This path will be used by CallReplay to place CDR data. By default, it will be stored /CCM_IP/
in DATA_FOLDER/Cdr/CCM_IP (e.g. C:\CallReplay\Cdr\10.1.0.30\).

Click the  button.Add

It will take a while until CallManager starts uploading information to CallReplay, and once it does, you should be able to see statistics from the Sys
 menu.tem > CDR Verifier

Recording

Recording Overview
Network Interface
Call Managers (PBX)
Silence Compression
SPAN Troubleshooting
SPAN Recording
Forked Recording
IPTrade Turret Recording
Mitel SRC Recording
Silent Monitoring/Recording Supported Devices
JTAPI Encrypted Call Support

Recording Overview

CallReplay Call Recorder offers two methods for recording calls: Forked (SPANless) and SPAN recording. The modern, recommended, recording 
method is Forked Recording, because of its ease of installation.

For Cisco CallManager Express please use SPAN recording, and manually set the PBX type to Express, as auto-detection will not work.

Network Interface

Because monitoring ports cannot usually transmit traffic, for production setups the server you are using must have a minimum of two network 
cards for the application to function properly. One of them will be used for general network traffic and accessing Application Web Administration 
Interface and the other for listening VOIP related traffic. The NIC selected for website access should have a static IP address. 

Important

The monitoring NIC should not have a routable IP address, because network switches inhibit the transmission of packets from 
ports used as port mirroring destinations. If the OS routes packets through this port, all sent packets will be discarded. Remove 
the IP address of the monitoring NIC, or set it a non-routable address, such as 1.1.1.1.

We assume that you have already configured your network switches in order to mirror all VOIP traffic from VOIP LAN to the monitoring NIC of 
CallReplay otherwise no calls will be recorded.

Open the  page, and choose which NIC is used for VOIP traffic and which one is used for web administration Recording / Network Interfaces
and general traffic.

To set NIC used for VoIP:

Go to Recording > Network Interfaces
Click in the column Record? the NIC that would be reserved for recording

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/serviceability_cdr_management01.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/serviceability_cdr_ftp.png
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If you have configured port mirroring correctly, calls will start being recorded immediately. For CallManager Express please see the PBX 
Configuration chapter.

Call Managers (PBX)

Call Managers page allows the management of Cisco CallManagers, Mitel, IPTrade, NEC and other supported telephony controllers.

To add a controller:

Go to .Recording > Call Managers (PBX)
Click  button.Add PBX
Provide all data required by  window (see how to edit a controller)Edit PBX
Click .Ok

To delete a controller:

Go to .Recording > Call Managers (PBX)
Check the row(s) containing the controller(s) to delete
Click  button.Delete PBX
Click  to confirm deletionYes

To edit a controller:

Go to .Recording > Call Managers (PBX)
Click  if you create a new cotroller, or  to modify and existing one.Add PBX Edit
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Observation: Cisco CallManager Express is a different type than Cisco CallManager.

Silence Compression

CallReplay has the capability to 'trim' silence allowing a significant reduction of RTP and as consequence a better usage of storage space or 
transmission bandwidth.

Voice Activity Detection is used with IP Trade Turrets to trigger call recording based on the voice signal intensity. It can also be used with Radio 
Gateways and other analog-to-IP equipment with no call signalling.

To configure silence compression:

Go to .Recording > Silence Compression
Change settings according with your requirements.
Click .Save

VAD Sensitivity: the level of voice activation detection from which the signal is not considered silence. The default value is Normal 
(40dB). Other values are Low (30 dB, noisy environment) and High (50 dB, Catch every breath).
Silence Compression: keep or not to-keep the silence within recordings 
VAD separation interval: it is enabled when silence is removed within recordings. This is the length of the silence inserted between 
active signals.
Recording prolog duration: it means the length of the interval recorded before the moment of active signal.
Recording prolog threshold:
Silence before stopping VAD calls: after specified value of silence the recorded call will be stopped.
Maximum VAD call duration:

CallReplay has the capability to 'trim' silence allowing a significant reduction of RTP and as consequence a better usage of storage 
space or transmission bandwidth.

Voice Activity Detection is used with IP Trade Turrets to trigger call recording based on the voice signal intensity. It can also be used with 
Radio Gateways and other analog-to-IP equipment with no call signalling.

To configure silence compression:

Go to .Recording > Silence Compression
Change settings according with your requirements.



3.  Click .Save

VAD Sensitivity: the level of voice activation detection from which the signal is not considered silence. The default value is 
Normal (40dB). Other values are Low (30 dB, noisy environment) and High (50 dB, Catch every breath).
Silence Compression: keep or not to-keep the silence within recordings 
VAD separation interval: it is enabled when silence is removed within recordings. This is the length of the silence inserted 
between active signals.
Recording prolog duration: it means the length of the interval recorded before the moment of active signal.
Recording prolog threshold:
Silence before stopping VAD calls: after specified value of silence the recorded call will be stopped.
Maximum VAD call duration:

SPAN Troubleshooting

Analyze Captured Packets

 

By clicking , you can see the amount of TCP or UDP Packets captured from and to an IP Address.Recording / SPAN Troubleshooting
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 Recording > SPAN Troubleshooting

 

Analyze the Network Configuration

Install Wireshark

Wireshark is a free, open source packet analyzer.

 Download the latest version from http://wireshark.org/download
At installation, be sure to   select the "Install WinPcap" option (as it is already installed by CallRecorder) or the "Start WinPcap service not
"NPF" at startup" option.

 

Capture a Call

Go to the   menu and select   Capture Interfaces
In the interfaces window select the   network card you configured for monitoring in CallRecorder.same

 

Press the   button  Capture
Start a call
Talk a few seconds. In the capture window you should see the number of udp and tcp packets growing. If not, you either configured 
SPAN incorrectly or captured on the wrong NIC.
Stop the call.
Stop the network capture.

 Usually there should be about 100 udp packets per second, so if this number is much smaller, then your server may not be capturing the voice 
stream.

 Verify Call Control

 In the main   window, set the filter to:Wireshark

 ip.addr == {TEST_PHONE_IP} &&skinny.messageid == 0x8a

 and press  .Apply

 The StartMediaTransmission and OpenReceiveChannelAck messages are critical for recording to work.

 If you don't see any skinny packets after applying this filter, then your call control stream was not captured. To fix it, you should configure SPAN 
to your computer, in order to forward traffic from  .CallManager

 

 

Verify the Voice Streams

In the main window, set the filter to:

ip.addr == {TEST_PHONE_IP} && udp

and press .Apply
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If you don't see any RTP packets after applying this filter, then your voice stream was not captured. To fix it, you should configure span to forward 
traffic from your phones to your computer.

If you are only interested in external calls, you should only forward traffic from your voice gateway to your computer.

SPAN Recording

Overview

 

SPAN Recording is a passive technology. It is working with all Cisco CallManagers and all kind of phones as long as they are SIP or SKINNY 
compatible.

The application service uses a network interface card functioning in promiscuous mode, in order to capture packets for the conversation 
recording. The host computer or the server need a network connection to voice traffic, through a non-switched hub or through a SPAN port on a 
switch. For more information about configuring a mirrored port on your switch, read the user manual of the switch. 
You can also visit the following links:

Configuring the Catalyst Switched Port Analyzer (SPAN) Feature: http://www.cisco.com/en/US/products/hw/switches/ps708
/products_tech_note09186a008015c612.shtml

The application works by monitoring phone traffic. There are two types of phone traffic essential to recording: 

signaling (call control), from phones or voice gateway to CallManager
audio streams (RTP), from phone to phone, or from phone to voice gateway

To be able to record calls, the application needs to intercept both types of traffic, call control and audio streams.
For more information about network sniffing please read the Wireshark FAQ: http://www.wireshark.org/faq.html

 

Virtual Environment

 

The difficulty in getting SPAN based/passive recording functional in a virtual environment is the SPAN itself. With the SPAN configured on a 
physical switch port, all communication will be directed to a physical NIC. This physical NIC MUST be bound on the VM. The reason behind this 
statement is because most virtual NIC software cannot forward the SPAN information to the VM, so the physical NIC will be required to be bound 
to the VM. Because of this requirement installing the application into a virtual environment may not be advisable. Allocating a physical device to a 
VM only requires VT-D support in the host CPU.

Implementation Options

 

There are two main options in configuring network monitoring:  

Record only external calls. This is the easiest. All you need to do is to have the CallManager and the voice gateway in the same switch 
and SPAN them to the application recording port. If you have them in different switches you need two monitoring NICs in the recording 
application server, one for each switch. Make sure you are mirroring all the CallManagers and voice gateways, including backup 
ones.
Record all calls, external and internal. For that you will need to have all the phones' traffic monitored to the application recording port. 
That is, monitor all switches with phones. Usually this is done by placing all the phones in a separate VLAN, and monitoring that VLAN. 
Using a VLAN also has the advantage of discarding the general (PC) network traffic, which can overload the monitoring interface in both 
the switch and in the recording application.

 

 

Because RTP traffic (green and red in the figure) travels directly between end points, without going through CallManager, in a large enterprise 
with multiple switches only external calls (PSTN) can be recorded in a cost effective way (one recorder for each voice gateway). 
To record internal calls also, one recorder per switch with IP phones is required.

 

Server Side Network configuration 

http://www.cisco.com/en/US/products/hw/switches/ps708/products_tech_note09186a008015c612.shtml
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Because monitoring ports cannot usually transmit traffic, for production setups the server you are using must have a minimum of two network 
cards for the application to function properly. One of them will be used for general network traffic and accessing Application Web Administration 
Interface and the other for listening VOIP related traffic. The NIC selected for website access should have a static IP address. 

 The monitoring NIC should not have a routable IP address, because network switches inhibit the transmission of packets from ports Important:
used as port mirroring destinations. If the OS routes packets through this port, all sent packets will be discarded. Remove the IP address of the 
monitoring NIC, or set it a non-routable address, such as 1.1.1.1.

We assume that you have already configured your network switches in order to mirror all VOIP traffic from VOIP LAN to the monitoring NIC of 
CallReplay otherwise no calls will be recorded.

Open the  page, and choose which NIC is used for VOIP traffic and which one is used for web administration Recording / Network Interfaces
and general traffic.

 Recording > Network Interfaces

 

If you have configured port mirroring correctly, calls will start being recorded immediately. For CallManager Express please see the PBX 
Configuration chapter.

Forked Recording

Overview of Forked Recording

Forked Recording (SPANless Recording) is an active recording technology, available only on Cisco CallManager platforms newer than 5.0 and 
selected Cisco phone models.

Benefits of Forked Recording

Ease of use and management

Establish complex network architectures not depending on SPAN ports
Move or reconfigure complete departments with ease
Improve control over branch locations

Economical

Reduce OPEX with easier administration as no configuration of SPAN ports is necessary
Reduced CAPEX – need for fewer elements at the branches

Reliable and secure

Free-up resources for network monitoring
Increase reliability utilizing system resources better and more manageable
Security: Both authenticated and encrypted mode can never be recorded.
Geo redundancy available with high bandwidth utilization



Additionally

Internal calls recording = RSPAN, VLAN split to meet SPAN capacity
Cisco plans support for CUCM 8.x
Built-in support of recording notification tones

How does it work?

The Cisco Unified Communications Manager (CUCM) interface provides two recording modes:

Automatic recording of all calls on line appearance. This method is invoked by CUCM.
Selective recording allowing users to record ad-hoc or also allows recording server to record based on business rules and events.

After calling-in and routing the call to an agent CUCM automatically sends two call setup messages to the Agent device. The 1st call is the agent 
stream and the 2nd call is customer stream. The Communications Manager invites the recorder to both calls via SIP Trunk and the recorder 
accepts both calls and receives RTP streams from Agent device.

Forked recording requires:

usage of the silent monitoring and recording interface of CUCM
CUCM version 6.0 and higher
the usage of 3rd generation phones, as detailed here:
https://developer.cisco.com/site/uc-manager-sip/faq/supported/

Usage notes

Usage of a SPANless configuration will bring major benefits as long as the following requirements and notes are taken into account:

The expected increase of network traffic
For PSTN recording only GW span works as simple trunk recording
TAP switches are able to handle high traffic in large architectures with centralized GW
Only 3rd generation phones are supported
There is no support for active-active redundancy
Interruptions in recording may occur if a failure occurs during the call
If the WAN capacity is limited, redundant recording may be refused (due to automated network intelligence)

Further reading: http://www.cisco.com/en/US/docs/voice_ip_comm/uc_system/UC6.0.1/features_apps/CMmonrec.html

Configuration Steps

In the Recording / PBXs page, the Forked Recording wizard button appears only when the PBX type is Cisco CallManager, version is greater or 
equal than 5.0 and the Forked Recording Protocol is selected in the PBX options. In this case other recording protocols should be disabled.

Step 1. Add a new PBX by clicking the Add PBX button.

 

Step 2. The PBX window appears allowing to edit the PBX settings.

Menu > PBXs

https://developer.cisco.com/site/uc-manager-sip/faq/supported/
http://www.cisco.com/en/US/docs/voice_ip_comm/uc_system/UC6.0.1/features_apps/CMmonrec.html


 

You may need to change the following fields according to the type of PBX:

PBX Type: This drop-drown list allows the selection of the PBX type, for example CallManager or CallManager Express.
IP Addresses: The IP address of the PBX. If there are more IPs (for example if you have a cluster) separate the IP addresses by the 
semi-colon character, or write each address separately on one line.
External SIP Trunks: The names (not the IP) of your external SIP Trunks. You can enter them one per line.
PBX Version: The version of the PBX. It is important to insert the correct version using at least the MINOR:MAJOR notation (e.g. 10.5 or 
10.5.2 for CallManager 10.5.2). CallReplay takes this version into account when it communicates with CallManager (make sure to 
change this to the appropriate value when upgrading your CallManager).
Park Numbers: A list of park numbers. Use the X wildcard to stand for zero or any one digit.

Step 3. Select Next to continue to the Protocols configuration



Protocols: This list should already have Forked Recording enabled. Make sure it is checked.

Step 4 Edit Cisco Forked Recording



Ensure the password for CallReplay user is set correctly

One the settings are in place click OK and then click the Next  button.

 

Step 5 Confirm CUCM Username and password and confirm Certificate Security



Click Next button to conitnue



In the next page leave all the fields unchanged unless instructed by technical support. The Phone Service IP address must be routable from the 
phones' VLAN.  Press   button.Next

 

Step 5. Here you must select the correct CallManager Group, Recorder Extension for CallReplay, the IP address of the CallReply recorder ( also 
needs to be routable from a phone's IP address ), CSS and Device Pool for recorded phones, Security Profile, SIP port of Callreplay ( Syn-Apps' 
SA-Announce also uses a SIP trunk so make sure in that case to select another port, such as 5061 ) and the RTP port range used by CallReplay 
for receiving audio streams. The recorder extension must have the same number of digits as recorded extensions. 

 

Recording Profile > Calling Search Space: This is the CSS that will be selected for the Recording Profile. Please use a CSS setting so 
that the recording trunk phone number is reachable from all the phones which are to be recorded. A quick test would be to call the 
recording trunk extension from one of the phones to be recorded. The trunk should answer instantaneously and just silence should be 
heard. A fast busy tone would indicate a connection problem.
Recording Profile > Recorder Extension: The number that will be used to send SIP invites to CallReplay in order to record. The 
number of digits for this extension must be the same as the number of digits of the recorded phones.



SIP Trunk > SIP recorder host (this): Enter the IP of the CallReplay machine
SIP Trunk > Device Pool: Choose the Device Pool that the SIP trunk will be created with. The recorder should be in a DP which 
matches the physical location of the recording server. It is recommended that a dedicated DP is used for the recorder so that no media 
transcoding is necessary.
SIP Trunk > Security Profile: Make sure to select a Non Secure SIP Trunk Profile or a New Non Secure SIP Trunk Profile, this profile 
will be configured to use TCP for incoming connections.



Once the above settings are complete, press the  button. CallReplay will tell CallManager to create all the profiles (if they already exist, they Next
will be overwritten).

 

Step 6. In the Device Pools section you can select which device pool to configure. Once you selected a Device Pool, in the next tab (Phones), 
only the phones in the respective pool will be shown.

 

 

Step 7. Here you have a list of a phones to manage. Check all phones to record under   column. Similarly for   check box. When Record Service
that check-box is selected, the phone will be subscribed to   (see step 2), which will become available on the   butCallReplay Phone Service Service
ton (on the phone). Thus we can control recording and monitoring independently for each phone. You can   phones by  filter Selected / Unselected 
(record or service) or by typing some text to search in all columns. Checking  will update all phones with current Reconfigure all controlled phones
shown configuration, otherwise only changed ones will be updated.
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Step 8. Press the  button and the selection will be processed. The status of processing will be shown.Next



 

Press the  button to close the wizard configuration utility.Close

Cisco CallManager - Alternative/Manual Configuration for Forked Recording

We recommend the usage of CallReplay Forked wizard for configuring your Cisco CallManager. But if you do not want to use this feature follow 
these steps to prepare your Cisco CallManager for recording.

1. Recording phones using forked

You need to create by hand an application user -  , a new SIP profile -  , a recording profile - CallReplay CallReplay SIP profile CallReplay recording 
 and a new trunk -  .profile CallReplay_SIP_trunk

CallReplay Application User

In CallManager site administration go to User Management > Application User. Press the  button and fill in the text fields as follows:Add New

Application User Information

        :  User ID* CallReplay
        :  Password password
         : Confirm Password password
        *: select Presence Group  Standard Presence group
    Device Information
        Add from the list of Available Devices to the list of Controlled Devices the phones who will be recorded.
        If you use EM profiles then add from "Available Profiles" list to the "CTI Controlled Device Profiles" list the EM profiles who will be recorded.
    Permissions Information
        : press  button and in list shown subscribe to the following groups:  ,  Groups Add to User Group  Standard CTI Enabled Standard CTI Allow 

 and CallRecording, Standard CTI Allow Control of Phones supporting Connected Xfer and conf Standard CTI Allow Control of Phones supporting 
Rollover Mode

Press Save button to create the application user.

CallReplay SIP profile
 

In CallManager site administration go to Device > Device Settings > SIP Profile. Press   button and fill in the   with value Add New Name* CallReplay
. Save the changesSIP profile

CallReplay recording profile
 

In CallManager site administration go to Device > Device Settings > Recording Profile. Press   button and fill in the text fields as follow:Add New
     : Name* CallReplay recording profile
     : select a CSSRecording Calling Search Space
     : xxx - the extension used by CallRecorder. The value must be an unassigned EXT and having the same Recording Destination Address*
number of digits as recorded extensions. If extensions in your network have 3 digits then this value must have 3 digits too.

Save the changes.
 

CallReplay SIP trunk
 

In CallManager site administration go to Device > Trunk and press   button to define a new trunk. Fill in the text fields:Add New
    Device Information
        :   where   is the IP of CallRecorder server. Device Name* CallReplay_SIP_trunk_xx.xx.xx.xx xx.xx.xx.xx
         : select the device pool where the recorded phones are registeredDevice Pool*
    SIP information
         : the IP of the CallRecorder serverDestination Address
         : the port where CallRecorder is listening ( default value 5061 )Destination Port
         : select security profile accordinglySIP Trunk Security Profile*
         : select CallReplay SIP profile ( created  before )SIP Profile*

Save the changes.

2. Subscribe phones to the CallReplay Call Recorder Phone Service

Create CallReplay Call Recorder phone service



1.  

2.  

In CallManager site administration go to Device > Device Settings > Phone Services and press   button to define a new phone service. Add New
Fill in the text fields as follow:
     : Service Name* CallReplay Call Recorder

:     ASCII Service Name* CallReplay Call Recorder
     : Service Description CallReplay Call Recorder
     :   ( you can get these values from CallReplay Site Configuration );Service URL http://IP:PORT/CallRecorder/phoneService
     : select Service Category* XML Service
     : select Service Type* Standard IP Phone Service        
     : Enable True

Save the changes.

Subscribe devices

In CallManager site administration go to Device > Phone and perform the following operations: 
    -select a device;
    -select from   dropdown list option   and press   button;Related Links Subscribe/Unsubscribe Service Go
    -in the new windows select   serviceCallReplay Call Recorder
    -press   and after that  button;Next  Subscribe
    -close the window;
After the phone reset the   becomes available for use.CallReplay Phone Service

IPTrade Turret Recording

CallReplay offers an fully integrated solution for IPTrade Turret VoIP recording, based on active recording. This means that the two platforms are 
directly connected, without requiring any additional hardware and a duplicate media stream of every conversation to be recorded is sent from the 
turret to the recorder.

Active Recording Settings

This section represents the system configuration for active recording on IPTrade turrets. Administrators must set the CallReplay as the recording 
server and indicate that server to the IPTrade system. The following settings have been confirmed to work on CallReplay v7.5 and IPTrade Turret 
Support Server (TSS) v7.4.24448.

Call Replay settings

On Recording > PBX page choose   and from the  , select  .New PBX PBX Type IPTrade Active

Fill in the the   field with any address (ex. 0.0.0.0).IP Addresses

From   list choose IPTrade Active and edit the protocol settings:Protocols

Port indicates the TCP port to listen for incoming connections. Default value is 4456. You must enable this port into the system firewall.
VAD indicates whether or not the recording server will use Voice Activity Detection settings for silence detection.

Turret Support Server settings

Following settings are required on TSS for integration with the active recoding system.

Set turret recording engine

Go to System\Settings\FTP settings (turrets) and on Recorder - Basic Mode choose "iptrade" for Recorder compatibility.

 
Configure the voice recorder address
Use the same location as the one used to set the recording engine or inside user profile (Account Management\User) or shared profile 
(Account Management\Shared Profile) go to Settings tab and on Recorder - Basic Mode configure the voice recorder location in form 
<protocol>://<address>:<port> where:

Protocol indicates the voice recording system to be considered. Valid values are: vrc.
Address indicates the IP address or the name of the voice recording service host.
Port indicates the TCP port to connect to the voice recording service (same as the value used to configure the IPTrade Active Recording 
protocol in CallReplay).

Example: vrc://192.168.0.1:4456

Mitel SRC Recording

http://ipport/


1.  

1.  
2.  

2.  

1.  

Overview:

The Secure Recording Connector (SRC) service is a software solution that facilitates the recording of Mitel encrypted voice streams by third-party 
call recording equipment (CRE). The Mitel Border Gateway (MBG) server with SRC service is positioned on the LAN between the ICP and the 
sets to be recorded. It accepts requests from an authorized CRE to establish taps in the voice stream. These taps are separate (mirrored) 
streams from the SRC to the CRE.

CallReplay offers a native solution for recording calls on Mitel PBXs for both direct and indirect call recording setups.

 

 

There are several abbreviations that will be used throughout this manual: 

SRC - Secure Recording Connector

MBG - Mitel Border Gateway

MCD - Mitel Communications Director

ICP - Integrated Communications Platform

 

2. Requirements:

 1. Mitel SRC Licenses

SRC Licenses are a Mitel requirement and need to be acquired from your Mitel Partner. You need as many licenses as CallReplay Licenses.

When the licenses are installed, you should be able to see the number of Tap Licenses in  .MBG -> Status -> Dashboard

 

 

 

3. SRC configuration and phones setup

 

For CallReplay to be able to receive audio streams, each phone that needs recording, has to be routed through the MBG (Mitel Border 
Gateway). This can be achieved in two ways:

Register the phone to the MBG
Set phone's Gateway to be the address of the MBG
 

In each MCD or ICP 3300 you need to allow   and  .HCI Call Controll Monitor

This can be achieved in the section  .System Properties -> System Feature Settings -> Class of Service Options

Program this setting for the COSs (Class of Services) of the phone sets that need recording.

 

 

4. CallReplay Setup

 

CallReplay Wizard

For CallReplay to be able to communicate with your PBX, it needs to know some information about your network set-up. 

In PBXs menu, there are the following options that you need to set:
IP Addresses: The IP addresses of your   (usually the same IP as the  ).SRC MBG
PBX Type: This should be set as Mitel MCD 3300
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PBX Version: The version of your MCD or ICP (eg. 6.0)

 

 

 

         2. Accept CallReplay Certificate in  :MBG Certificate Management

 

 

CallReplay certificate should be in the Queued CSRs.

Note: It might be required that you restart the CallReplay Service

 

         3. Set the phone sets that you want to record.

Switch back to CallReplay Wizard interface. In the PBXs menu, on the entry created in Step 1, click  , and choose the phones Active Recording
that you want to be recorded as shown in the following image:

 

Silent Monitoring/Recording Supported Devices

Silent Monitoring/Recording supported device reference chart for Cisco Unified Call Manager

 

Device/Phone 
Model

SCCP SIP Gateway-
based 
RTP-
Unencrypted 
Media

Automatic 
Recording

Silent 
Selective 
Recording

User 
Selective 
Recording 
(available in 
UCM 9.0 or 
later)

Device-based 
(built-in-
bridge)
RTP- 
Unencrypted 
Media

Device-based 
(built-in-
bridge)
sRTP - 
Encrypted 
Media

Remarks

Analog Phone N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 12 S  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 12 SP  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 30 SP+ N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 3905 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 3911 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 6901 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 6911 XX XX  Requires UCM 
10.0(1) or later

Yes Yes Yes Requires UCM 
7.1(3) or later

Requires UCM 
8.0(1) or later

CUCM 7.1(3) 
requires Dec 
2009 firmware 
update 8.5(4)

Cisco 6921 XX XX Requires UCM 
10.0(1) or later

Yes Yes Yes Requires UCM 
7.1(3) or later

Requires 
UCM  8.0(1) or 
later

CUCM 7.1(3) 
requires Dec 
2009 firmware 
update 8.5(4)

Cisco 6941 XX XX Requires UCM 
10.0(1) or later

Yes  Yes  Yes Requires UCM 
7.1(3) or later

Requires UCM 
8.0(1) or later

CUCM 7.1(3) 
requires Dec 
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2009 firmware 
update 8.5(4)

Cisco 6945  XX XX  Requires UCM 
10.0(1) or later

Yes  Yes   Yes Requires UCM 
7.1(3) or later 

Requires UCM 
8.0(1) or later

Requires 
firmware 9.1(2) 
or later. SIP 
support in 9.2
(1) in July 
2011.

Cisco 6961 XX XX Requires UCM 
10.0(1) or later

Yes Yes Yes Requires UCM 
7.1(3) or later

Requires UCM 
8.0(1) or later

CUCM 7.1(3) 
requires Dec 
2009 firmware 
update 8.5(4)

Cisco 7811   XX Requires UCM 
10.0(1) or later

Yes Yes Yes Requires UCM 
6.0(1) or later

Requires UCM 
8.0(1) or later 

 

Cisco 7821   XX  Requires UCM 
10.0(1) or later 

Yes Yes Yes Requires SIP 
firmware 10.1
(1)

Requires SIP 
firmware 10.1
(1)

 

Cisco 7841   XX  Requires UCM 
10.0(1) or later 

Yes Yes Yes Requires SIP 
firmware 10.1
(1)

Requires SIP 
firmware 10.1
(1)

 

Cisco 7861   XX Requires UCM 
10.0(1) or later

Yes Yes Yes Requires SIP 
firmware 10.1
(1)

 Requires SIP 
firmware 10.1
(1)

 

Cisco 7902  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 7905  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 7906  XX XX Requires UCM 
10.0(1) or later

Yes Yes SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later

Requires UCM 
8.0(1) or later

 

Cisco 7910  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 7911  XX XX Requires UCM 
10.0(1) or later 

Yes Yes SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later

Requires UCM 
8.0(1) or later

 

Cisco 7912  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 7914 
Sidecar

XX   Requires UCM 
10.0(1) or later

Yes Yes SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later

 

Cisco 7915 
Sidecar

XX XX Requires UCM 
10.0(1) or later

Yes Yes SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later

 

Cisco 7916 
Sidecar

XX XX Requires UCM 
10.0(1) or later

Yes Yes SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later

 

Cisco CKEM 
Sidecar

  XX Requires UCM 
10.0(1) or later

Yes Yes SCCP, Yes 
SIP, Device-
based only

Requires UCM 
7.1(3) or later 

Requires UCM 
8.0(1) or later 

 

Cisco 7920  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 7921  XX   Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later

Requires UCM 
8.0(1) or later

CUCM 6.0(1) 
requires Aug 
2008 firmware 
update

Cisco 7925 & 
7925-EX

XX   Requires UCM 
10.0(1) or later

Yes Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later 

 

Cisco 7926 XX   Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
7.0(1) or later

Requires UCM 
7.0(1) or later 

 

Cisco 7931  XX   Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later

Requires UCM 
8.0(1) or later 

 

Cisco 7935  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 7936  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device 



Cisco 7937  XX   Requires UCM 
10.0(1) or later 

Yes Yes SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later

No Requires 
March 2010 
firmware 
update 1.4(1)

Cisco 7940  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device 

Cisco 7941  XX XX Requires UCM 
10.0(1) or later

Yes Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later

Requires UCM 
8.0(1) or later

 

Cisco 7941G-
GE 

XX XX Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later

 

Cisco 7942  XX XX Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later

Requires UCM 
8.0(1) or later

 

Cisco 7945  XX XX Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

6.0(1) or later Requires UCM 
8.0(1) or later

 

Cisco 7960  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 7961  XX XX Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later

Requires UCM 
8.0(1) or later 

 

Cisco 7961G-
GE 

XX XX Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later 

End of 
Software 
Maintenance 
Release 2009

Cisco 7962  XX XX Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later  

 

Cisco 7965  XX XX Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later 

 

Cisco 7970  XX XX Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later 

End of 
Software 
Maintenance 
Release 2009

Cisco 7971  XX XX Requires UCM 
10.0(1) or later 

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later 

End of 
Software 
Maintenance 
Release 2009

Cisco 7975  XX XX Requires UCM 
10.0(1) or later

Yes  Yes  SCCP, Yes 
SIP, Device-
based only

Requires UCM 
6.0(1) or later 

Requires UCM 
8.0(1) or later

 

Cisco 7985  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco 8811   XX Requires UCM 
10.0(1) or later

Yes Yes Yes Requires UCM 
8.5(1) or later 

Requires UCM 
8.6(2) or later  

 

Cisco 8831   XX Requires UCM 
10.0(1) or later

Yes Yes SIP, Device-
based only

Requires SIP 
firmware 9.3(2)

Requires SIP 
firmware 9.3(2)

 

Cisco 8841   XX Requires UCM 
10.0(1) or later

Yes Yes Yes Requires UCM 
8.5(1) or later 

Requires UCM 
8.6(2) or later  

 

Cisco 8845   XX Requires UCM 
10.0(1) or later 

Yes Yes Yes Requires UCM 
8.5(1) or later 

Requires UCM 
8.6(2) or later 

 

Cisco 8851   XX Requires UCM 
10.0(1) or later

Yes Yes Yes Requires UCM 
8.5(1) or later 

Requires UCM 
8.6(2) or later  

 

Cisco 8861   XX Requires UCM 
10.0(1) or later

Yes Yes Yes Requires UCM 
8.5(1) or later 

Requires UCM 
8.6(2) or later   

 

Cisco 8865   XX Requires UCM 
10.0(1) or later 

Yes Yes Yes Requires UCM 
8.5(1) or later 

Requires UCM 
8.6(2) or 
later    

 

Cisco 8941  XX XX Requires UCM 
10.0(1) or later

Yes   Yes   Yes Requires UCM 
7.1(5) or later 

Requires UCM 
8.0(1) or later

Requires 
firmware 9.1(2) 
or later. SIP 
support in 9.2
(1) in July 
2011.

Cisco 8945  XX XX Requires UCM 
10.0(1) or later

Yes Yes Yes Requires UCM 
7.1(5) or later 

Requires UCM 
8.0(1) or later

Requires 
firmware 9.1(2) 
or later. SIP 



support in 9.2
(1) in July 
2011.

Cisco 8961   XX Requires UCM 
10.0(1) or later 

Yes Yes  Yes Requires UCM 
7.1(3) or later  

Requires UCM 
8.0(1) or later  

CUCM 8.0(1) 
requires March 
2010 firmware 
update 9.0(2)

Cisco 9951   XX Requires UCM 
10.0(1) or later

Yes  Yes  Yes  Requires UCM 
7.1(3) or later  

Requires UCM 
8.0(1) or later  

CUCM 8.0(1) 
requires March 
2010 firmware 
update 9.0(2) 
CUCM 10.0(1) 
requires 
firmware 
update 9.4.1

Cisco 9965   XX Requires UCM 
10.0(1) or later 

Yes Yes Yes Requires UCM 
7.1(3) or later  

Requires UCM 
8.0(1) or later  

CUCM 8.0(1) 
requires March 
2010 firmware 
update 9.0(2)

Cisco 9971   XX Requires UCM 
10.0(1) or later

Yes  Yes  Yes  Requires UCM 
7.1(3) or later

Requires UCM 
8.0(1) or later

CUCM 8.0(1) 
requires March 
2010 firmware 
update 9.0(2) 
CUCM 10.0(1) 
requires 
firmware 
update 9.4.1

Cisco DX650   XX Requires UCM 
10.0(1) or later

Yes Yes Yes Requires UCM 
7.1(3) or later

Requires UCM 
8.5(1) or later

CUCM 10.0(1) 
requires 
firmware 
update 10.1.1

Cisco DX70   XX N/A Yes Yes N/A Requires UCM 
8.5(1) or later

Requires UCM 
8.5(1) or later

 

Cisco DX80   XX N/A Yes Yes N/A Requires UCM 
8.5(1) or later

Requires UCM 
8.5(1) or later

 

Cisco E20 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco EX60 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco EX90 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco CTS 500 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco CTS 
500-32

N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco CTS (all 
other device 
models)

N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco ATA 186 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco ATA 187 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco ATA 188 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco IP 
Communicato
r 

XX XX Requires UCM 
10.0(1) or later 

Yes Yes SCCP, Yes 
SIP, Device-
based only

Requires CIPC 
v7.0(1) or later

No  

Cisco Jabber 
for Windows -
Softphone 
Mode

  XX Requires UCM 
10.0(1) or later

Yes Yes No Requires 
Jabber for 
Windows 9.2 
or later

Requires 
Jabber for 
Windows 9.2 
or later

 

Cisco Jabber 
for Windows -
Extend
/Connect 
Mode

N/A N/A Requires 
Jabber for 
Windows 9.2 
or later and 
UCM 10.0(1) 
or later

Yes Yes No N/A N/A  

Cisco Jabber 
for Windows -

N/A N/A Refer to the 
device model 
under remote 

Refer to the 
device model 
under remote 

Refer to the 
device model 
under remote 

Refer to the 
device model 
under remote 

Refer to the 
device model 
under remote 

Refer to the 
device model 
under remote 

Refer to the 
device model 
under remote 



Remote 
Desktop 
Control Mode

control to 
determine 
support. 

control to 
determine 
support. 

control to 
determine 
support. 

control to 
determine 
support. 

control to 
determine 
support.

control to 
determine 
support.

control to 
determine 
support.

Cisco Jabber 
for Mac -
Softphone 
Mode

  XX Requires UCM 
10.0(1) or later

Yes Yes No Requires 
Jabber for Mac 
9.2 or later

Requires 
Jabber for Mac 
9.2 or later

 

Cisco Jabber 
for Mac 
- Remote 
Desktop 
Control Mode

N/A N/A Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support.  

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Cisco Jabber 
for iPad (Wifi-
only)

N/A N/A Requires UCM 
10.0(1) or later

Yes Yes No N/A N/A  

Cisco Jabber 
for iPhone

N/A N/A Requires UCM 
10.0(1) or later

Yes Yes No N/A N/A  

Cisco Jabber 
for Android

N/A N/A Requires UCM 
10.0(1) or later 

Yes Yes No N/A N/A  

Cisco Unified 
Personal 
Communicato
r - Softphone 
Mode 

N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Cisco Unified 
Personal 
Communicato
r - Remote 
Desktop 
Control Mode

N/A N/A Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Cisco Unified 
Communicatio
ns Integration 
for Microsoft 
Office 
Communicato
r/Lync -
Softphone 
Modes

N/A N/A Requires UCM 
10.0(1) or later 

Yes Yes No N/A N/A  

Cisco Unified 
Communicatio
ns Integration 
for Microsoft 
Office 
Communicato
r/Lync -
Remote 
Desktop 
Control Mode

N/A N/A Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Cisco Unified 
Communicatio
ns for RTX 
(CUCRTX) -
Softphone 
Mode

N/A N/A Requires UCM 
10.0(1) or later

Yes Yes No N/A N/A  

Cisco Unified 
Communicatio
ns for RTX 
(CUCRTX) 
- Remote 
Desktop 
Control Mode

N/A N/A Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Cisco Web 
Communicato
r forWx Social 
-Softphone 
Mode

N/A N/A Requires UCM 
10.0(1) or later 

Yes Yes No N/A N/A  

Cisco Web 
Communicato
r forWx Social 
- Remote 
Desktop 
Control Mode

N/A N/A Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Cisco Unified 
Communicatio
ns Integration 
for WebEx 

N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device



1.  

Connect -
Softphone 
Mode

Cisco Unified 
Communicatio
ns Integration 
for WebEx 
Connect 
- Remote 
Desktop 
Control Mode

N/A N/A Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support. 

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

Refer to the 
device model 
under remote 
control to 
determine 
support.

VGC Phone  N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

VG224 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

VG248 N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

CTI Port N/A N/A Requires UCM 
10.0(1) or later

Yes Yes Yes N/A N/A  

CTI Remote 
Device 
(Extend & 
Connect)

N/A N/A Requires UCM 
10.0(1) or later

Yes Yes Yes N/A N/A  

CTI Route 
Point

N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

CTI Route 
Point (Pilot 
Point)

N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

ISDN BRI 
Phone

N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Carrier 
Integrated 
Mobile

N/A N/A Requires UCM 
10.0(1) or later

Yes Yes No N/A N/A  

IMS Client N/A N/A Requires UCM 
10.0(1) or later

Yes Yes No N/A N/A  

Mobile 
Communicator

N/A N/A N/A N/A N/A N/A N/A N/A Not a 
supported 
device

Nokia S60 N/A N/A Requires UCM 
10.0(1) or later

Yes Yes Yes via DTMF N/A N/A  

Remote 
Destination 
Profile (Single 
Number 
Reach)

N/A N/A Requires UCM 
10.0(1) or later

Yes Yes Yes via DTMF N/A N/A  

JTAPI Encrypted Call Support

To enable support of encrypted calls the following actions will need to be performed

From within the Call Replay administration GUI

Navigate to Call Managers and Add a PBX



1.  Add the appropriate details for the highlight boxes in the image

NOTE: Ensure IP addresses include Publisher and all subscribers, FQDN can be used but are not recommended.

Select Next, You will then be presented with the following protocols screen



On Cisco Forked Recording - Select Edit and ensure Secured is enabled/checked

Select OK and Next



Fill out the connection details for your CUCM

select EDIT KEYSTORE,

Within Keystore Editor select  to create a self sign certificate + NEW

NOTE: you may also import your own certificate here from a trusted Certificate Authority in X.509 .PEM format

Next export the certificate, and return to Authentication page by selecting SAVE and then select NEXT.



On the FORKED OPTIONS page ensure you have the required Call Security (Secure RTP) and that JTAPI security is set to Secure (TLS). Also 
make a note of the Instance ID and the Authentication Code by clicking the eye icon.



Select NEXT

If required Modify the Service Name and Description  and verify the Phone service Address (this) is correct – this should be the IP address of the 
Call Replay server, then Select NEXT

If required modify the Profile name or leave as default, modify Call Search Space and Call Manager Group as required or leave as default,



Leave Recording profile as default or modify if required, select Next

On the SIP trunk tab ensure that you have selected Secure (TLS) - you do not need to be concerned with Certificate editor if yu followed the 
earlier instructions.

Make any other requried modifications here or leave as default

Select Next

On the Route Pattern tab leave as default or make modifications if required

Select Next



Selecrt your device Pool

Select Next

Select the desired phones / extensions for inclusion for recording

Select Next



Close the wizard

Then launch the web interface for CUCM (Cisco Unified Communications Manager)

And select Operating System Administration

Login into the interface as an administrator

Then select Security / Certificate Management



Select Upload Certificate/Certificate chain

Select Upload Certificate/Certicate chain



For Certificate Purpose* ensure to select CallManager-trust

Provide a freindly name for example : servername-callreplay

Select Browse from Upload File and locate the certificate you exported from the CallReplay keystore earlier or one that you have created 
from your own CA which is also imported to the Call Replay keystore store.

Select Upload

Once uploaded please note the requirement to restart CallManager and TFTP service on CUCM



Mobile Recorder

Android Recorder

Overview

CallReplay Recorder for Android allows you to record calls you make on your Android phones. Since the space available to store these 
recordings can be very limited, you can upload them on CallReplay Cloud Server.

For this, you need to have an account on a CallReplay Cloud Server. If you intend to use the public CallReplay Cloud Server located at Cloud 
 please follow the next step.CallReplay Administration

If you want to use a custom installation of CallReplay Cloud Server, please skip to the 'Configuring phone to upload calls' section.

The minimum supported version is Android 2.3.3.

For the best experience with Cloud Server, you need a Flash enabled desktop/laptop/tablet browser. The cloud application is not optimized for 
mobile phone screens.

In this manual, the terms 'tenant', 'tenant account', 'cloud account', 'organization' all refers to the cloud space created in 
CallReplay for your organization. 'Organization ID' is the generated ID of this cloud space. The terms 'administrator', 
'administrative user' and 'administrative account' refers to the person who has the login credentials needed to manage your 
tenant account (received in the e-mail specified at tenant creation). The administrator could create more administrative users for 
the same tenant, and also more non-administrative users.

Cloud Server Account

Using a Flash enabled browser, go to  page.CallReplay Cloud Register

You need to enter at least a valid e-mail, your name, your company name and a valid web site. The trial account created this way is valid for 1 
 and have  of disk space at your disposal.month 200 MB

You can use the same account for multiple phones, however, the trial account is valid for maximum 5 phones.

If you want to extend the validity of the account or change the available disk space or phone numbers, please contact sales or support (see CallR
).eplay Contact

You will receive an e-mail with subject " " to the address provided, containing login credentials for administrative account CallReplay Tenant
(administrator) of this tenant

 

Once the account is activate you can access it through  and providing your credentials.http://cloud.call-replay.com/

If you've wondered what is the 'Request Cloud Account' item from 'Upload Server' section of settings page, it has been added 
for people who do not read the manual. If we've shown the link in the Android Call Recorder, most people will tend to click it and 
expect to work on their mobile phone. Since it doesn't, and we do not want them to type the whole address, we send them an e-
mail which they can read on another computer and click the link.

 

 

Configuring Phone

Upon registering a new tenant (cloud account), you will receive an e-mail containing credentials required to access the cloud server.

Please go to 'Settings' section and click on 'Upload Server'. You will see a page like this:

 

'Upload Server' -  for public CallReplay Cloud Server, your server name / IP for custom installation of CallReplay.cloud.call-replay.com

'Organization ID' - this is your tenant account ID; it is named 'Organization ID' to avoid confusion with administrator ID. A since you can upload 
calls from multiple phones on the same account.

http://cloud.call-replay.com
http://cloud.call-replay.com
http://call-replay.com/go/register
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'Password' - this is the upload password, not your administrator password. To can change this password, login to your tenant administrator 
account, and go to 'Headquarters / Branch Replication'. Here you can find the 'connection password' on 'Headquarters tab'.

'Use Wi-Fi' - to automatically upload calls whenever a Wi-Fi connection is available.

'Use mobile connections' - useful when a Wi-Fi connection is not available. The upload on the mobile connection can be slower and might be 
subject to additional fees from your mobile carrier.

'On roaming' - check this if you want to upload calls when you travel to other countries and want to upload calls. Warning: this can be costly.

'Test Upload' - click this to see if all is configured correctly.

'Delete after Upload' - check this if you want to automatically delete uploaded records from your phone - this way you make space to record other 
calls.

Call Encryption

Overview

We value your privacy, so we introduced an OpenPGP public key encryption of recorded calls. If you do not have an OpenPGP public / private 
key pair, you can generate them using a 3rd party software which you can find freely on Internet (see notes on the bottom of the page).

Setting Up Call Encryption

Login as administrator on CallReplay Cloud Server and go to 'Storage' / 'Recording Encryption'.

Click the 'Upload' button and select your OpenPGP public key file. If successful, you will see some of the details of the public key certificate. For 
the purpose of call encryption, the certificate does not need to be signed.

Upon the next connection of your mobile phones to your tenant, the certificate will be sent to all of them and all subsequent calls will be encrypted 
using this certificate.

You can change the certificate any time you want, and only subsequent calls will be encrypted with the new certificate, the older ones will remain 
as they were (unencrypted or encrypted with older certificates).

Notes:
1.Uploading only the public key gives you a great deal of privacy: in case of mobile phone theft, the calls could not be listened. The drawback is 
that neither you can listen to your calls on the mobile phone.
2.In case you've wondered if someone could listen to your calls uploaded to CallReplay Cloud Server, this way you can be sure nobody could. 
The drawback is the same: neither you can listen to your calls online.

The only way to listen to your encrypted calls is to download them to a computer, decrypt them with your PGP capable software of your choice. 
The software will ask you for the private key, will decrypt your files and you can listen to them using your favorite WAV/3GPP player.

Quick setup for call encryption

You can also generate an OpenPGP private/public key pair using 'Generate' button from the same page. After entering a name and a password, 
you will be prompted to save the private key to your computer.

The generated public key will be sent to your mobile phones and calls will be encrypted using it. However, the private key will not be kept on our 
server for security reasons, so you should take proper care of the saved key. If you lose it, your calls cannot be decrypted.

Mobile phone encryption configuration

For the encryption to work, after you generated or uploaded a public key on CallReplay Cloud Server, you need to connect your mobile to the 
server. Make sure you have Internet connection then either go to 'Status' page and click 'Upload Now'.

Then go to the 'Settings' page, 'Upload Server' section and you should see the new info on 'Encryption Certificate' item.

Note: in case you have used multiple certificates over time, for each encrypted call you will see the certificate details on the call details page; this 
way you can identify the private key required to decrypt the recorded call.

Notes

The encrypted file conforms with OpenPGP standard (RFC 4880). The encryption is done using AES 256.

The generated certificate is a 1024-bit RSA key OpenPGP.

If you do not have an OpenPGP certificate and prefer creating one yourself, you can use GPG4Win, which is a 3rd party OpenPGP compliant 
free software for Windows: .http://www.gpg4win.org

Storage

http://www.gpg4win.org
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Storage Volumes
Storage Settings
Statistics
File Renaming

Storage Volumes

The  page allows to set the folder where the calls are stored. You can add new folders, you can join folder, or you can remove Storage Volume
folders. In addition, CallReplay can manage multiple volumes that store calls on separate drives, which will be used in a round-robin order.

To add new volumes:

Go to .Storage > Storage Volumes
Click .Add Volume
Provide all the information requested.
Click .Ok

Path - destination path on the local HD, where calls will be stored
Quota - the maximum space that can be used to store calls. (0 means unlimited).
Reserved - the reserved storage space for CallReplay

When (  becomes lower than , a warning e-mail will be sent to Used Space + Remaining Drive Free Space) Reserved Space
the administrator.

The storage volume list will be updated, including the information about free space on available drivers.

To join volumes:

Go to .Storage > Storage Volumes
Click  on the volume that will be the sourceJoin
Select the  as the destination folder.To
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Click .Join

To delete a volume:

Go to .Storage > Storage Volumes
Select the row with volume to delete.
Click on the red circle button in  column.Delete
Click  to confirm.Yes

NOTES

A deleted volume is not removed when it contains calls, will be just marked as deleted and no other calls will be stored on it.

Storage Settings

The Advanced Storage Configuration holds further options for the storage of recordings:

Force G729 Recompression will encode all the stored files with the G.729

Capture Device Buffer  - sets the buffer used to store capture packets in SPAN recording. It should not be changed unless instructed by 
CallReplay support team.

Recording Database Connections should correspond to the number of cores your processor has. Overprovisioning or high processor load from 
other applications can lead to a decrease in performance or, in the case of SPAN, recording quality

Recording Disk Threads should be tailored to the write speed and IOPS of your current storage. For regular HDD storage, 2 threads should be 
enough, and SSD based storage can use more threads, up to the number of processing cores.

Temporary Files Expiration - time to keep the temporary files, such as .PNG files

Recording Storage Format allows you to set the file type of the recorded calls. The recording is made in RTP format, and the default setting is 
to convert it to SPX, which is the most efficient compression format, designed specifically for voice audio. When changing the format, you have 
the option of converting existing recordings to the new format, as well.

Conversion Threads should be provisioned like Recording Disk Threads, as they have the same impact on the storage hardware. For regular 
HDD storage, 2 threads should be enough, and SSD based storage can use more threads, up to the number of processing cores.

Player Access Password - auto generated password, used for interfacing with APIs



 

Statistics

File Renaming

File Name Templates   allows the administrator to change the template used to generate the file names for storing recorded calls.Page

The file names template is a string containing macros that expand to values related to the call like the call ID or caller number. The list of macro 
names that can be used is displayed in the " " table as can be seen in the image. Click on a macro name from the table to have the Fields list
macro included at the end of the current file names template. You can also type any macro name from the table in the   field, File Name Template
surrounded by barces   and  , to include the macro in the file name template string.{ }

The   field (below the   field) shows how a file name would look like using the currently displayed template string. Also Example File Name Template
watch the   field for errors like a worng macro name being typed in the template string.Example

A new file name template takes effect after the   button is pressed, and the new template will be used for all calls recorded thereafter. To also Save
apply the new template to all the old files, that is to rename all previous files using the new template, use the " " radio Rename existing files ?
group and select the option " ". For this case, you can use the " " field as an estimate of the number of calls that would have to be On Call count
renamed with this option.

After saving a new template with the option to rename existing files, you can see the rename progress in the   field, in the format Call count
"remaning / total", like for example "120 / 550".

The " " button restores the current template string into the   field, and discards any changes you might have typed in the Cancel File Name Template
input box.

 Storage > File Renaming

Playback

Replay Calls
Audit
Active Calls
SPX Player
RTP Transcoder

Replay Calls

Replay Calls is the main user page. From here you can play and search recordings and access the call details page for each recording. Video 
recordings can also be accessed from here
Introduction

From the top menu choose Replay Calls:

Menu > Replay Calls

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-08-Aug/ra6file_renaming.png


Replay Calls is the main user page. From here you can play and search recordings and access the call details page for each recording. Video 
recordings can also be accessed from here

In the Replay Calls menu you can see by default all calls recorded today. They can be found in the All folder on the left and distributed among the 
users.

Note: You can only play the calls that your user account has permission to playback.

Quick Play

Next we will show you how to listen to your calls. Click on speaker icon and a new window will appear, as shown below:

Replay Calls >Audio Player



From here you can Play your selected call by pressing the highlighted button.
Notice the caller ID's, first the caller then the called, the start date&time and the duration.

In addition to listening to recorded calls, if a call has an associated video recording, shown by a blue-lit film icon, you can click on it to view the 
video recording with the call's audio.

Replay Calls > Video Player

 This will open the Video Player window, which displayes the time, date and the parties involved with the associated call.

Live Monitoring

If a call is in progress it can be monitored. For this, press the speaker button and the following window is shown:

Replay Calls >Audio Player

Properties of the call

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-08-Aug/17-videoplay.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-08-Aug/03-monitor.png


Click on the details icon and choose Properties, or double-click a call. A window will appear, as shown below:

Replay Calls >Call Properties

Here you can view the call/video details, view/change the call's category, set description of call or export the call to email or to disk using wav or 
speex format. 

Categories
You can assign more users/categories to a call

 

Editing Descriptions

In the text box enter the description you want. Then click the Save button.

 

Quick Save - Mailing

The options presented are Save Call or sending it by E-mail using the Wav or the Speex format.

 

Wav (Waveform Audio) A common audio uncompressed file format for 
Windows computers (.wav). It has the advantage of being played by 
any Microsoft Windows sound application, the disadvantage being 
that it is uncompressed, thus, very large.

Speex A free software speech codec designed for VoIP which provides 
very good quality speech and low bit rate, thus, occupying less disk 
space.
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External Numbers - Customers

Phone number can be added/assigned to a customer. For this, click on exclamation mark and choose Add to Customer

Replay Calls > Add to Customer

You can select an existing customer or add a new one.

Advanced Search

In the Replay Calls page you can search recordings

You can add filters to the selection tool by clicking the ... button so you may customize your search.. After you finish the filter, press Refresh.

In the Replay Calls menu you can see by default all calls recorded today. They can be found in the All folder on the left and distributed among the 
users.

Note: You can only play the calls that your user account has permission to playback.

Quick Play

Next we will show you how to listen to your calls. Click on speaker icon and a new window will appear, as shown below:

Replay Calls >Audio Player

From here you can Play your selected call by pressing the highlighted button.
Notice the caller ID's, first the caller then the called, the start date&time and the duration.

In addition to listening to recorded calls, if a call has an associated video recording, shown by a blue-lit film icon, you can click on it to view the 
video recording with the call's audio.

Replay Calls > Video Player

 This will open the Video Player window, which displayes the time, date and the parties involved with the associated call.

Live Monitoring

If a call is in progress it can be monitored by selecting the play icon within Active Calls
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Properties of the call

Click on the details icon and choose Properties, or double-click a call. A window will appear, as shown below:

Replay Calls >Call Properties

Here you can view the call/video details, view/change the call's category, set description of call or export the call to email or to disk using wav or 
speex format. 

Categories
You can assign more users/categories to a call

 

Editing Descriptions

In the text box enter the description you want. Then click the Save button.
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Quick Save - Mailing

The options presented are Save Call or sending it by E-mail using the Wav or the Speex format.

 

Wav (Waveform Audio) A common audio uncompressed file format for 
Windows computers (.wav). It has the advantage of being played by 
any Microsoft Windows sound application, the disadvantage being 
that it is uncompressed, thus, very large.

Speex A free software speech codec designed for VoIP which provides 
very good quality speech and low bit rate, thus, occupying less disk 
space.

 

External Numbers - Customers

Phone number can be added/assigned to a customer. For this, click on exclamation mark and choose Add to Customer

Replay Calls > Add to Customer

You can select an existing customer or add a new one.

Advanced Search

In the Replay Calls page you can search recordings

You can add filters to the selection tool by clicking the ... button so you may customize your search.. After you finish the filter, press Refresh.

Audit

Audit Page allows to see who listened a call or who emailed a call. You can filter by auditor or / and by phone number. This option is accessible 
through Playback / Audit

 Playback > Audit
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Active Calls

The  window allows the administrators to view calls which are in progress, monitor them, stop or resume recording. This window is Active Calls
available from the  menu or from the  ribbon button below the menu.Playback > Active Calls Active Calls

 Playback > Active Calls

The top area of the window, above the current calls table shows the following information:

Max Licensed Calls: Shows the total number of active, in-progress calls that can be recorded.
Recorded Calls: Shows the total number of active, in-progress calls.
Waiting for demand: Shows the total number of calls which can be recorded on-demand when the user selects Record This Call on the 
phone services button. Call recording can also be triggered from the CallReplay interface by clicking the Start Recording icon on a call in 
the list. If the user doesn't request recording, the call will not be recorded.
Not Recorded Calls: Shows the total number of active, in-progress calls which will not be recorded. This can happen due to not enough 
channels or because of the currently set Recording Policies in Unified Configuration.

 When calls are in progress, they will appear in this window. The columns include the following information:

Calling Party: The number of the calling party.
Called Party: The number of the called party.
Start Time: The date and time the call started.
Recording Policy: The rules/policies which influence the call and the allocated pool.
Actions: The 4 icons allow to monitor an active conversation, start recording a call in progress, pause/resume recording a call in 
progress, or stop recording. When a recording is stopped, the call is discarded and there will be no possibility to record it again.

 

Monitoring a Call

To listen to a call in progress, click the Speaker icon in the rightmost column. A popup window playing the current conversation should appear:



Recording Policy Column

The  column displays information about the recording policies which are matched for an active call. For example, in the Recording Policy
screenshot below the active call is recorded only , meaning the user would have to press the Record This Call phone service button On-Demand
for the call to get recorded, or the administrator would have to click the Demand Recording button from the CallReplay interface.

On-Demand Policy

Once the user presses the Record This Call button on the phone, a Pool name will appear showing where the call was categorized:

 

Automatic / Reserved Policy

A call which will be automatically recorded is listed using either Dynamic Automatic or Reserved Automatic recording policies:

 

Direction Not Recorded

The calls which have a direction for which there are policies in place which explicitly forbid recording (from Unified Configuration > Recording 
Policy) will not be recorded. These include calls of types: internal, outbound, inbound, parked, transferred. They should not appear in the Active 
Calls window.

SPX Player

RTP Transcoder

Quality

Quality Overview
Quality Standards
Reports
Answers
Records Evaluation

Quality Overview

With CallReplay you have the ability to evaluate any call whether it happens in real-time (active call), whether it is a record of a call/conference or 
screen record. This can be achieved through customized templated questionnaires ('quality standards') which can be linked with a particular call.
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Templated questionnaires ('quality standards') represents a set of questions that have predefined answers and which can be grouped into various 
categories depending on your particular needs.

Quality Standards

Before being able to evaluate real-time calls, or their recorded version, you must define quality standards. 

To create a standard:

Go to .Quality > Quality Standard
Click .Add
Enter the name for the standard.
Leave Disabled unchecked.
Click .Save

At any time you can disable a standard by checking . This will make the standard and questions within unavailable to Disabled
be linked with call records.

To create a category:

Go to .Quality > Quality Standards
Click  button beside the standard where you want the category to be created.Edit



Click  button.Add
Select  for the drop-down menu.Category

Introduce the category name as you like to be refered.

Chose parent for the new category. It can be a standard category or a subcategory.

Click .Ok

You can change the parent for a category by clicking on  button.Edit

To create a question:

Go to Quality > Quality Standards.

Select the category where you want the question to be

Click  button.Add

Select  for the drop-down menu.Question



Click .Ok

Reports

To view reports containing questionnaire scores, go to .Quality>Reports

Choose report type , period of the report, department, and quality standard.Compare Scores

To view the report press  button.View report

To export the report to an excel file, press button.Export 
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Answers

CallReplay allows the creation of custom 'answers' templates that can be bounded with a particular question depending on specific evaluation 
needs and based on the context of that question.

To create a new answer template:

Go to .Quality > Quality Standards
Click  button.Add

Enabled: Make the answer available to be bound with a question
Label: Meaningful label.

With the installation, CallReplay provides seven predefined answer templates that can be used and which cover most of the 
needs.

To edit an answer template:

Go to .Quality > Answers
Select the template you want to edit.
Click  button.Edit



4.  To edit a specific lable, double click over it.

Records Evaluation

The questionnaires are accessible in recordings list through extended actions menu

Replay Calls > Call Menu

The   shows the questionnaires labels with the following information:Questionnaire menu

Evaluated questionnaires have their score displayed to the right of the label ( ex: QS 1 ).
If a questionnaire has a '  answer, then it will be marked and shown as incomplete ( ex: sta ).N/A'
If a questionnaire has all '  answers, the score will not be shown and only incomplete will be displayed ( ex: QS 2 ).N/A'
For not evaluated questionnaires, only their label is shown (ex: sta (2) ).

Evaluating Records
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Once a standard is 'attached'  to a record, you will not be able to alter the standard anymore. Exception to this is that you can 
activate or deactivate it.

Calculating scores

Each question can have a real  between 0 and 1 ( ex: 0.5 = 50% ). Unanswered questions have score 0.score

The question's  is a coefficient applied to the question's score. It has one the following values:importance

Ignored = 0
Low = 0.5
Medium = 1
Important = 2

Questions of type text have importance 0 ( Ignored ) by default.

When calculating the  of an evaluated questionnaire, the following algorithm is applied:total score

Sum each answered question's score multiplied by its importance
Scale the result to a value between 0 and 100% based on the maximum achievable score of the questionnaire ( sum of answered 
questions importance ).

Note that if a question has '  answer, it is ignored from evaluation's total score. It is considered as if not answered, and the total score will N/A'
scale accordingly ( for example, you can have an evaluation score of 100% if the first question is answered '1 and the second is answered ' 0' 'N/A
).

 

See Reports section for details about how to generate reports.

Backup

Backup Overview

CallReplay provides backup and recovery capabilities that allows you to create ‘images’ (i.e. files and metadata), and copy those to a secondary 
site for archive in case of failure. At any time, in case data must return to original condition, CallReplay can use the backups for recovery.

Configuring Backup

To Backup call recordings to a local folder or a windows network share, use the Backup page.

To perform a backup:

Go to  menu.Backup > Backup
Click .Start

Before doing a backup, ensure everything is in place in terms of configuration.

General Tab



In the above image, you can see the General tab, which contains usual backup options.

The  is always appended to the backup root directory, and represents the backup folder name backup label
The  is the location where the backup will be done. Pressing the "..." button, will focus the backup root directory to be changed. full path
The   is a value that limits total call recordings backup size (example: to fit some external disk)maximum backup size

 

               

The   can have one of the following values:archive type
Incremental - only calls that haven't been backed up will be included
Full - all calls will be included ( other filters applied)

After backup, you can choose three options:
Don't Remove - calls will remain in the database and on disk as they are
Remove File, Keep Call Info - will remove the recording files, but will keep the calls in the database, and will not allow you to 
listen them
Remove File and Call Info - will remove the recording files from disk, and remove all calls information from database

The   from the backup root directory is shown on the rightfree space

Advanced Tab

This tab includes additional options for backup.

The   is the backup root directory, where a new folder will be created with the same name as the  .backups directory backup label

You can enter a   folder location here, or a  with the following format:local  windows network share  \\<server>\<path>

When a  is inputted, additional fields will be shown for entering  ,   and  . windows network share domain username password

 

The   has three choices:backup period

Any calls will be included
Between - only calls that have the starting date between the two values will be included. 
If one date is empty, then only one date will be used as the interval margin. (example: start date is empty, end date is non-empty, then 
only calls with a start date below entered end date will be considered for backup).

Older than - only calls that have the starting date older than input value will be included
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You can choose which calls to be backed up by  , clicking the departments combo, and a pop-up will appear:departments

Status Tab

The status tab is visible only when the backup process starts.

 

In the progress bar, processed calls and remaining calls count are shown.

The text area below shows errors occurred during backup.

Restore

To Restore a backup made in a windows network share or local folder, use the Restore page.

 Backup > Restore

Options

To view backups, select a   or a   from which to restore calls.backup root folder backup folder

You can also select a location from a   (following the pattern   )  and login information will be shown:windows network share \\<server>\<path>

If no login information is inputted, then the default user GUEST will be used.

You can sort backup entries in the left grid by clicking on a column header.

In the right panel,     of the selected backup are shown (same as  ).backup details backup history

The refresh button located right of the input directory helps rescan for backups.

You can select either to   files from the backup or to   them.move copy
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If   files is selected, the backup files are removed during restore process.move
If   files is selected, the backup files remain intact.copy

 To start a   operation you can:restore

click   button in the last column of the  , which restores the backup form that rowrestore grid

 click   button from the   to restore selected backuprestore details panel

 

Status

Once the restore operation has started, the status tab becomes visible:

History

To view a history of backups made and their details, use the Backup History page:

 

The left grid shows all backups made. You can sort entries by clicking any column header.

The right panel shows selected  .backup details

Screen Recorder

Screen Recorder Overview

CallReplay offers full integration with Memolith, that is a component that let  you record the desktop. By this you can see what happened on the 
screen while the agent was talling on the phone.

 You can deploy Memolith on any number of user desktops and then choose from within CallReplay to record the respective desktop when a call 
is placed (or to always record). Memolith will record the desktop and then upload the resulting videos to CallReplay, from which you can see a list 
of calls and their associated videos.

Memolith runs as a background service.

Screen Recorder Settings

Settings

There are several options through wich you can configure how recording is performed.
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Capture

Establish the FPS (Frame Per Second) and the mode in which recording is activated

To configure capture mode:

Go to .Screen Recorder > Settings
Introduce the desired frame rate. Default is  sec (that is 2 fps)0.5
Recording can be always on, or triggered by a phone call
Click .Save

Compression

Here you may choose when to compress the video files, whether to resize the resulting videos, as well as CPU usage. The recorder may 
compress the video files on Desktop (on the client where Memolith is installed), on Server (in CallReplay when the video is uploaded), or at 
Playback (when playing the video):





Configuring Storage Management

You may also choose how you want to manage the space to be used by the video recordings:

 Configuring Upload Settings

Change the delay between attempts to upload the videos from Memolith to CallReplay:
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Screen Recorders

CallReplay can be used as a centralized storage for any Memolith recorder installed in your network. From Screen Recorders page you can 
control how CallReplay shall behave but also all Memolith recorders that are registered as 'uploaders'

To accept uploads:

Go to .Screen Recorder > Screen Recorders
Check .Accept Uploads
Provide a .Connection Password
Click  buton.Save
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Accept Uploads: Instructs CallReplay to accept upload video records comming from Memolith recorders
Connection Password: Connection password that Memolith recorders must use in order to upload video records
Upload Address: CallReplay's IP address used by Memolith recorder to upload video records

In order for upload operation to work both CallReplay and Memolith recorder must be configured for uploads. This means that 
CallReplay must have Accept Uploads checked and Memolith recorder must have Upload = Enabled.

To disabled a Memolith recorder (stop a recorder to upload):

Go to .Screen Recorder > Screen Recorders
Select the Memolith recorder you want to 'disable'.
Click .Edit
Uncheck .Enabled

To delete a Memolith recorder:

Go to .Screen Recorder > Screen Recorders
Check the row containing the recorder you want to delete
Click  buton.Delete

Download and Install

With Memolith it is possible to optimize common business processes by observing how critical tasks get done. Memolith is the software used to 
record the desktop. CallReplay offers full integration with Memolith.

You can deploy Memolith on any number of user desktops - it runs as a background process - and then choose from within CallReplay to record 
the respective desktop when a call is placed (or to always record). Memolith will record the desktop and then upload the resulting videos to 
CallReplay, from which you can see a list of calls and their associated videos.

System Requirements
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The system requirements for the Memolith screen recorder client software are:

CPU: 
Minimum - modern dual core cpu (2.5Ghz Pentium or equivalent)
Recommended - quad core CPU (first generation i5 or equivalent)

RAM: 
Minimum - 2GB
Recommended - 4GB

Disk:
2GB free space minimum

Download and Install Memolith

To download Memolith:

Go to Screen .Recorder > Download Setup

Run MemolithDesktopSetup.exe and follow installation wizard instructions
Click .Install

 

Configure Memolith

Once installation performed, the setup wizzard provides access to configuration screens. These configuration screens can be accessed later 
through Windows System Tray.

To configure Memolith (Sys Tray):

Go to .Windows System Tray
Double click on Memolith icon, or right click on it for the pop-up menu.
Select . Configuration
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Recording Status

This tab will show general Memolith information, as well as the recording and connection status:

Recording Tab

In this tab you may change the local storage folder and choose which monitors to record:

Connection Tab

This tab will allow you to enter your CallReplay username and password. This will be the account with which Memolith will authenticate to 
CallReplay. For Phone Call - activated recording, the respective user in CallReplay must have a phone or DN associated.

In addition, you will need to configure the server's address and the connection password that was set in the screen recorders tab in CallReplay.

Upload Tab

You can enable or disable uploading of videos to CallReplay from here, as well as upload manually:

Advanced Tab

This tab is used to troubleshoot and debug problems and monitor the recorder's activity:

 

Play Video Records

From the top of the Replay Calls window you can switch between Calls and Videos.

The Videos page shows a list of all video calls made during the selected date, unlinked to any phone calls. Their file name will reflect the host PC 
that was recorded. Click on the film icon to play.

Replay Calls > Videos

Session

Log Out

It is recommended that when you no logger need access to CallReplay to log out the application.

To log out from CallReplay:

Go to  and clickSession > Logout <user name>
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You can access  als from the toolbar.Logout

To check signed on user:

Go to .Session
The current user is showed beside  menu item.Logout

Change Password

CallReplay allows you to change your password or PIN at any time.

Change Login Password

If someone else has your password, then they can use the system impersonating your account. We recommend to change your 
password. Change your password immediately if you have any reason to believe that someone else had access to it or has broken into your 
account.

You should change your password periodically, ideally at least every six months.

To change your login password:

Go to   .Session | Change Password
Type your current password
Type the new password
Retype the new password for confirmation
Click .Save

Change Personal Identification Number (PIN)

If you are using CUC (Cisco Unicty Communication) you can change your associated user PIN at any time.

To change your login password:

Go to   .Session | Change Password
Type your PIN.
Type the new PIN.
Retype the new PIN for confirmation
Click .Save
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When you change your PIN make sure you follow security guidelines provided by system administrator.

Here are few good practices:

The PIN should not contain your primary extension or its reverse
The PIN should contain at least three different digits.
The digits should not all be consecutive, in ascending or descending order (for example, 12345 or 54321).
The PIN should not be a numeric representation of your first or last name, or the combination of your first and last names. (For example, 
if your name is John Doe, you could not use a numeric representation of johnd, johndoe, jdoe, doe.)

Companion Applications

CallReplay Administration

When you install CallReplay you can configure it to meet your specific needs. After you completed the setup you will have on the server: installed 
binaries, configured security permissions, configured registry settings, configured database, and the web site.

Please refer to Install and Setup on Windows section for more details on installing CallReplay.

You can access CallReplay in two ways: locally from the server, or remotely.

To access CallReplay locally:

Go to .Start > CallReplay > CallReplay Administration

 

To access CallReplay remotely:

Open your browser
In the address bar introduce the address where the server is installed

If you don't know the exact address, please your system administrator

Guides

Change/Reset Password

Reset Password
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Change Password

Each user that has permission to log in to application site can change his password and pin by clicking Session / Change Password.
He can change only password, only pin or both by leaving blank the undesired field.

LikeBe the first to like this

Site Configuration

 

 

You need to run Site Configuration with administrator privileges

https://docs.call-replay.com/display/CAM/08.1.+Users+Management


Software Updates

 

 

 

Get Support

CallReplay Get Support is a symbolic link provided for convenience giving quick access to the support web site that can be accessed at CallRepla
.y Contact

Sales

For any products and sales related questions including quotes, terms and conditions, or discounts available please contact us via:

E-mail: info@call-replay.com

Phone (USA): +1-480-240-2979

Phone (EU): +40-724-511-431

Technical

For any technical related questions and support, please contact us via:

E-mail: support@call-replay.com

Phone (EU): +40-724-511-431

Others

For more details about CallReplay please visit  website.CallReplay
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pgAdmin

CallReplay uses an embedded PostgresSQL and pgAdmin is a popular administration and development platform for PostgreSQL. Both 
PostgreSQL and pgAdmin comes together with CallReplay.

Database server configuration (e.g. port, user, password) are set during setup proceess

Default Port: 5432
Default User Name: callreplay
Default Password: CallReplay_2005

To open pgAdmin:

Go to .Start > CallReplay > pgAdmin

 

For more details and extensive documentation please go to  . https://www.pgadmin.org/docs/

TeamViewer

TeamViewer is a proprietary package for remote desktop control and sharing, online meetings, web conferencing and file transfer between 
computers or mobile devices.

It comes with  and is installed together with it.CallReplay

It is provided as a mean for a better support and you can use it to connect with our support specialists.

To open TeamViewer:

Go to .Start > CallReplay > TeamViewer
Transmit  and  to our support specialistsYour ID Password

For more details about TeamViewer features and other settings please check .TeamViewer Website

Localization+

Requirements

For creating a custom localization of CallRecorder you need at least version 7.1.10 of application installed using a full setup.

https://www.pgadmin.org/docs/
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Creating/editing CallReplay localization

CallReplay CallRecoder has two major components who need to be translated separately. One component is recorder service and other is site 
administration.

First thing which must be done is to create a copy of entire   folder into CallReplay data folder.   folder can be found in Translations Translations
installation path, usually c:\Program Files\CallReplay\System\Translations. Data folder is the folder where the database is kept, default value is C:
\CallReplay.

Once we have new   folder we can start to create/edit translations. All customizations must be done in this new   folder Translations Translations
otherwise will be lost after first running of CallReplay Software Update or after a full setup.

The tools used for translation are " "  and " ".translate_site.cmd translate_server.cmd

Create a new translation for CallRecorder site

Go to the new   folder created using indications from previous paragraph.Translations

Duble-click on " " file. If this is the first time when the translation tool is used you must select a language for translation tool translate_site.cmd
interface:

After language selection the main window of translation tools is shown:

Press the add language button:

Select desired language from the list:

The result is a new Language node:

 Now select the new language and translate every key from the master file to the new language. Next picture show how to do translate "All rights 
are reserved" to Korean.

 

The untranslated keys are shown with blue color. So it is easy to know which keys are translated and which not.

For saving the new language press "CTRL+S" which is a shortcut for File>Save option and a new file having name  will be  "site_xx.properties"
created where   is the language code.xx

Create a new localization for CallRecorder service

Go to new   folder and double-click on " ". The same tool as for translating site will be shown excepting that the Translations translate_server.cmd
keys are for CallRecorder service.

Create a new localization for CallRecoder service following the same steps as for CallRecorder site. The name of the new translation will be "serv
" where   is the language code.er_xx.properties xx

Activate a new localization

A new localization becomes active after including in file " " the line:  and restarting of CallRecorder service.locale.properties xx=Language 

e.g.: ko=

Editing an existing localization for CallRecorder site and service

Run the translation tool ( " " for site and " " for service ), select the language and edit the keys accordingly. translate_site.cmd translate_server.cmd
Save the changes ( CTRL+S or File > Save ).

Help

Manual
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CallReplay comes with two manuals available in HTML format, both providing detailed information about installing process, configuration, system 
requirements, step-by-step operations

To access manuals:

Go to Help > Manual
Choose the manual you want to consult

Administrator's Guide: A complete documentation for CallReplay.

User's Guide: A subset of the Administrator's Guide containg the information required by a regular end-user for day-to-day operation and usage 
of the CallReplay system.

You can download the PDF version of both manuals from  website.CallReplay

Service Debug Settings

To configure debug:

Go to .Help > Service Debug Settings
Change configuration according with your needs (or as per adviced by support people)
Click .Save

Debug Capture:
None:
Basic - Control Stream:
All - Control and Data Stream:

Debug Capture Duration: Duration 
Tracing Priority:

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-10-Oct/Screenshot-from-2016-10-23-09-51-20.png
http://call-replay.com/documentation
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-10-Oct/Screenshot-from-2016-10-23-11-09-50.png


Max Trace Files:

JTAPI Tracing: Debug various kind of tracing at various level of detail for JTAPI via JTPREFS.
Trace Levels: 

WARNING: Trace only warning type events
INFORMATIONAL: Trace only status events
DEBUG: Trace only debugging events. By enabling  you can enable or disable various debugging leveles.DEBUG

Debug Levels:
JTAPI_DEBUGGING: Trace methods and events.
JTAPINPL_DEBUGGING: Trace internal JTAPI implementation.
CTI_DEBUGGING: Trace CUCM events that are sent to the JTAPI implementation.
CTIIMPL_DEBUGGING: Trace internal CTICLIENT implementation.
PROTOCOL_DEBUGGING: Full CTI protocol decoding
MISC_DEBUGGING: Trace miscellaneous low-level debug.



Browser Logs

 

About

The About page provides detailed information about CallReplay version installed, along with all depended components and modules required.

The detailed information could include: description, version installed, release date, copyright, license terms, etc.

To access information:

Go to .Help > About...
Click the 'element' for which you want detailed information

How-to and Troubleshooting

Install and Activate Adobe Flash Player

The most appropiate approach is to go to and follow the instructions there.Adobe Flash Player Download

Optimizations

Software Optimizations

The Windows system cache is by default too large. Go to Control Panel / System / Advanced / Performance Settings / Advanced: 

set memory usage for best performance of Programs
set processor scheduling for best performance of background services

Configuring Speed Dial Buttons

Steps to follow to configure a speed dial button for using a phone service

1. Define a phone service ( Call Manager: Device> Device Settings> Phone Services ), as described in Chapter 19, for this URL:

 http://CallRecorderServer(:port)/CallRecorder/phoneService/onDemandPhoneDemandThisCall
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2. Create a new phone button template for your phones ( Call Manager: Device> Device Settings> Phone Button Template ) and select "Service 
URL"  for button which will be used as a speed dial for our phone service.

 

 

 

3. Go to Device> Phone and select new defined template on phones

 

 

4. Subscribe the phone to the phone service

 

 

 

 

5. The last step is to assign the new subscribed phone service to the phone button ( configured on step 2 ).

 

After phone reset, the speed dial is ready for use.

Testing The Setup

Make sure there are no pending alerts below the menu bar, by clicking on each alert and solving them.

 

 

Make a test call

Place a call to an external number. Recording internal calls with SPAN requires the traffic between the two devices must be spanned as well.

Playing a call

1. From the menu, choose Recordings / Replay Calls as shown below:                                                            
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2. If there are no calls displayed please skip to the "Troubleshooting" chapter.
3. Click the More button (three lines sign on the right side of every call), choose Properties and a new window, named "Call Details" will appear, 
as shown below. 
This page contains all information about a call like caller party, called party, duration of call, file size, file format. In the Advanced tab, you will get 
information about RTP traffic (ip address and port used in recording call). 
In the Description tab, you can provide a description for that call. In the Export tab by pressing "Save Call" you can save the call under Wav 
format or speex format. You can email that call by pressing "Send Email" button.

 Replay Calls > More button >  Properties

 

Click on Play Button.
A pop-up will be open and the recording will start playing.

 

 



Attention: You must have a valid G.729 license to play a G.729 recording, otherwise an error will be displayed.

Forked Recording Compatible Devices

Device/Phone Model Forked Recording Requirements

Analog Phone No N/A

Cisco 12 S  No N/A

Cisco 12 SP  No N/A

Cisco 30 SP+ No N/A

Cisco 3905 No N/A

Cisco 3911 No N/A

Cisco 6901 No N/A

Cisco 6911 Yes Requires UCM 7.1(3) or later

Cisco 6921 Yes Requires UCM 7.1(3) or later

Cisco 6941 Yes  Requires UCM 7.1(3) or later

Cisco 6945  Yes  Requires UCM 7.1(3) or later 

Cisco 6961 Yes Requires UCM 7.1(3) or later

Cisco 7811 Yes Requires UCM 6.0(1) or later

Cisco 7821 Yes Requires SIP firmware 10.1(1)

Cisco 7841 Yes Requires SIP firmware 10.1(1)

Cisco 7861 Yes Requires SIP firmware 10.1(1)

Cisco 7902  No N/A

Cisco 7905    No N/A

Cisco 7906  Yes Requires UCM 6.0(1) or later

Cisco 7910  No N/A

Cisco 7911  Yes Requires UCM 6.0(1) or later

Cisco 7912  No N/A

Cisco 7914 Sidecar Yes Requires UCM 6.0(1) or later 

Cisco 7915 Sidecar Yes Requires UCM 6.0(1) or later 

Cisco 7916 Sidecar Yes Requires UCM 6.0(1) or later 

Cisco CKEM Sidecar Yes Requires UCM 7.1(3) or later 

Cisco 7920  No N/A

Cisco 7921  Yes  Requires UCM 6.0(1) or later

Cisco 7925 & 7925-EX Yes Requires UCM 6.0(1) or later 

Cisco 7926 Yes  Requires UCM 7.0(1) or later

Cisco 7931  Yes  Requires UCM 6.0(1) or later

Cisco 7935  No N/A

Cisco 7936  No N/A

Cisco 7937  Yes Requires UCM 6.0(1) or later



Cisco 7940  No N/A

Cisco 7941  Yes Requires UCM 6.0(1) or later

Cisco 7941G-GE  Yes  Requires UCM 6.0(1) or later 

Cisco 7942  Yes  Requires UCM 6.0(1) or later

Cisco 7945  Yes  6.0(1) or later

Cisco 7960  No N/A

Cisco 7961  Yes  Requires UCM 6.0(1) or later

Cisco 7961G-GE  Yes  Requires UCM 6.0(1) or later 

Cisco 7962  Yes  Requires UCM 6.0(1) or later 

Cisco 7965  Yes  Requires UCM 6.0(1) or later 

Cisco 7970  Yes  Requires UCM 6.0(1) or later 

Cisco 7971  Yes  Requires UCM 6.0(1) or later 

Cisco 7975  Yes  Requires UCM 6.0(1) or later 

Cisco 7985  No N/A

Cisco 8811 Yes Requires UCM 8.5(1) or later 

Cisco 8831 Yes Requires SIP firmware 9.3(2)

Cisco 8841 Yes Requires UCM 8.5(1) or later 

Cisco 8845 Yes Requires UCM 8.5(1) or later 

Cisco 8851 Yes Requires UCM 8.5(1) or later 

Cisco 8861 Yes Requires UCM 8.5(1) or later 

Cisco 8865 Yes Requires UCM 8.5(1) or later 

Cisco 8941  Yes   Requires UCM 7.1(5) or later 

Cisco 8945  Yes Requires UCM 7.1(5) or later 

Cisco 8961 Yes Requires UCM 7.1(3) or later  

Cisco 9951 Yes  Requires UCM 7.1(3) or later  

Cisco 9965 Yes Requires UCM 7.1(3) or later  

Cisco 9971 Yes  Requires UCM 7.1(3) or later

Cisco DX650 Yes Requires UCM 7.1(3) or later

Cisco DX70 Yes Requires UCM 8.5(1) or later

Cisco DX80 Yes Requires UCM 8.5(1) or later

Cisco E20 No N/A

Cisco EX60 No N/A

Cisco EX90 No N/A

Cisco CTS 500 No N/A

Cisco CTS 500-32 No N/A

Cisco CTS (all other device models) No N/A

Cisco ATA 186 No N/A

Cisco ATA 187 No N/A



Cisco ATA 188 No N/A

Cisco IP Communicator  Yes Requires CIPC v7.0(1) or later

Cisco Jabber for Windows -Softphone 
Mode

Yes Requires Jabber for Windows 9.2 or later

Cisco Jabber for Windows -Extend
/Connect Mode

No N/A

Cisco Jabber for Windows -Remote 
Desktop Control Mode

Refer to the device model under remote 
control to determine support. 

Refer to the device model under remote 
control to determine support.

Cisco Jabber for Mac -Softphone Mode Yes Requires Jabber for Mac 9.2 or later

Cisco Jabber for Mac - Remote Desktop 
Control Mode

Refer to the device model under remote 
control to determine support.  

Refer to the device model under remote 
control to determine support.

Cisco Jabber for iPad (Wifi-only) No N/A

Cisco Jabber for iPhone No N/A

Cisco Jabber for Android No N/A

Cisco Unified Personal Communicator 
- Softphone Mode 

No N/A

Cisco Unified Personal Communicator 
- Remote Desktop Control Mode

Refer to the device model under remote 
control to determine support. 

Refer to the device model under remote 
control to determine support.

Cisco Unified Communications 
Integration for Microsoft Office 
Communicator/Lync -Softphone Modes

No N/A

Cisco Unified Communications 
Integration for Microsoft Office 
Communicator/Lync -Remote Desktop 
Control Mode

Refer to the device model under remote 
control to determine support.

Refer to the device model under remote 
control to determine support.

Cisco Unified Communications for RTX 
(CUCRTX) -Softphone Mode

No N/A

Cisco Unified Communications for RTX 
(CUCRTX) - Remote Desktop Control 
Mode

Refer to the device model under remote 
control to determine support. 

Refer to the device model under remote 
control to determine support.

Cisco Web Communicator forWx Social -
Softphone Mode

No N/A

Cisco Web Communicator forWx Social 
- Remote Desktop Control Mode

Refer to the device model under remote 
control to determine support. 

Refer to the device model under remote 
control to determine support.

Cisco Unified Communications 
Integration for WebEx Connect -
Softphone Mode

No N/A

Cisco Unified Communications 
Integration for WebEx Connect - Remote 
Desktop Control Mode

Refer to the device model under remote 
control to determine support. 

Refer to the device model under remote 
control to determine support.

VGC Phone  No N/A

VG224 No N/A

VG248 No N/A

CTI Port No N/A

CTI Remote Device (Extend & Connect) No N/A

CTI Route Point No N/A

CTI Route Point (Pilot Point) No N/A

ISDN BRI Phone No N/A



Carrier Integrated Mobile No N/A

IMS Client No N/A

Mobile Communicator No N/A

Nokia S60 No N/A

Remote Destination Profile (Single 
Number Reach)

No N/A

Phone Service

Using the IP Phone Service

The IP Phone Service allows users and managers alike to benefit from a couple of useful functions. 
These are: Recordings, Monitoring, and Record on demand. They are all described below in the application Main Menu section.
Note: The Monitoring function in the IP Phone Service is only accessible to Managers.

Login
Here you will enter your username and 
PIN.

Services Menu

After the login, you will be presented with this screen. 
1. Select the  menu.Services
2. From the  menu, select Services application name

 

Phone Service Menu

There are three options in the application IP Phone Service Main Menu:

Recordings It allows call playback, moving a call to a folder and email to the 
address set in the application Configuration.

Monitoring It allows monitoring of a selected phone number.

Record this call It allows Record on Demand.

Open  then select the extension you wantRecordings

In this case, the only selection you can monitor is 2002. To select another, press the  tab then enter the PIN accordingly.Other

Now you are presented with the list of calls from that extension. From here you can play move calls to application folders and E-mail them to the 
address set in application Configuration.

 

Monitoring

From the main  menu, open  and select the extension you wantapplication Monitoring

In this case, the only selection you can monitor is 2002. To select another, press the  tab then enter the PIN accordingly.Other

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/phoneserv1.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/phoneserv2.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/phoneserv3.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/phoneserv4.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/phoneserv5.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/phoneserv6.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/phoneserv7.png


Next you must enter the  you want to monitorPhone Number
After you have finished your selections, you should see the window below as a confirmation

 

On Demand Recording

Allows an agent the recording of a call in progress. Regardless of the moment you gave the command to record, that conversation will be 
recorded entirely.

Storage Volumes Best Practices

The following guide outlines some considerations to take into account when setting up your recording storage volume. In practice the application 
administrator should tahe into account the specific needs, available hardware and any other limitations.

The best and recommended way to set the CallReplay storage volume is on a dedicated partition, on  RAID (1 and above) protected drives.

Provisioning the total available space should be done considering the number of calls you want to store. You can estimate that each 1GB will 
hold approximately 160 hours of recordings using the speex format. That is, you can keep 96,000 calls of 10 minutes on one 100 GB HDD.

For setting the volumes in CallReplay we will consider 2 examples:

Example 1: A dedicated 500GB partition

In this case, you might want to have both the recordings and the data folder on the same partition. The quota setting, which sets the maximum 
ammount of space that the recordings may take should leave enough room on the partition for upgrade backups, logs, the database, and various 
misc files. Therefore, a 450GB quota  will leave a 50GB available space for the rest of the data folder, and various operations. If the data folder is 
actually on another partition, you can set a quota even higher, leaving only 2-3 GB of free space. The free space we consider even on a purely 
recording storage partition might be necessary at some moment if large file operations are necessary (archiving of a few days of recordings).

The reserved setting will keep you informed when the available space for recordings (that is free space available + the size of current recordings) 
drops below the specified amount. Use this to make sure that the database and other operations (database backup on the same partition, logs 
archiving on the same partition, etc) doesn't take up the space needed for recording. In this case, setting the reserved space just 2 GB smaller 
than the quota should achieve this purpose.

Example 2: A shared 100GB partition (OS partition)

For a partition that is shared between CallReplay and other applications and most notably the OS, it is necessary to leave enough space 
available for other uses. In this particular case, setting a quota of 40GB will leave 60GB available for the OS and other applications, which should 
suffice. The reserved space, in this case should be set lower, as it's quite possible that the OS and the other applications will take more space 
over time than initilaly envisioned. A 30 GB reserved space will allow the other disk users to take up to 10GB of the planned CallReplay storage 
space before sending notifications to the administrator.

The default 1GB Reserved freee space should also be increased for such a partition, 4GB should suffice.

CallRecorder Firewall Ports

Ports opened on the CallRecorder server

Protocol Port Purpose Configurable

UDP 1026 Database No

TCP/UDP 5060 SIP default port Yes

TCP 5432 Database Yes

TCP 8080 Jetty web server Yes

TCP 8081 Monitoring calls No

TCP 8079 Software update No

TCP 9000 Licensing No

TCP 9853 Replication No

UDP 25000-30000 RTP port range (even values) Yes
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CallManager Ports Required by Forked Recording

These ports must be opened on the CM server, or Forked will not work.

Protocol Port Purpose

TCP 2748 CTI

TCP 2749 JTAPI

TCP 2789 SIP default port

TCP 8443 AXL

TCP 443 HTTPS

UDP/TCP 5060 SIP

Reference: http://www.cisco.com/en/US/docs/voice_ip_comm/cucm/port/7_0/CCM_7.0PortList.pdf

Interfacing with CallReplay

CallReplay uses an embedded Postgres 9.0 database. To connect to it you can use PgAdmin III (Start / Programs / CallReplay / Support / 
PgAdmin III). It is also accesible from Java, C# and all programming languages which can access Postgres.

Port: Set during setup process, default 5432

User name: callreplay

Password: set during setup process, default CallReplay_2005

2. Automatic Login URL

http://SERVER:PORT/CallRecorder/?user=USER&password=PASSWORD&tenant=TENANT&lang=LANGUAGE

where SERVER is the call recorder ip/address, PORT is the  configured server port ( see CallReplay Site Configuration ), TENANT is the 
registered name of the tenant ( if not provided, the "default" tenant will be considered ), USER is the login name and PASSWORD is the 
password in clear text.

If you do not want to provide clear password, you may discard &password=, in that case CallReplay will ask you for password and use provided 
TENANT and USER.

Also, you can use the base URL with POST method, using the same keys and values as in normal URL:

  http://SERVER:PORT/CallRecorder/Login

 

3. Call Details

http://SERVER:PORT/CallRecorder/?callDetails=CALL_UUID&user=USER&password=PASSWORD&tenant=TENANT

where call_uuid is the uuid of the call, found in Advanced tab of Call Details.

Example:

 

http://www.cisco.com/en/US/docs/voice_ip_comm/cucm/port/7_0/CCM_7.0PortList.pdf
http://SERVERPORT
http://serverport/
http://SERVERPORT


Sometimes you may want to show only the Call Details dialog, in this case use the following url (note 'nomenu'): 

http://< server : port >/CallRecorder/?callDetails=< call uuid > &user=< user_name >&password=< clear_password >&tenant=< 
tenant_name >&nomenu

Observation: this is best used inside of an IFRAME

Example:

 

 

4. Call Playback

http://SERVER:PORT/CallRecorder/?player=CALL_UUID&user=USER&password=PASSWORD&tenant=TENANT

Observation: this is best used inside of an IFRAME 

 

5. File Storage URL

http://HOST:PORT/CallRecorder/Storage/STORAGE_VOLUME_ID/CALL_PATH

where  STORAGE_VOLUME_ID is the volume index number in the table   and CALL_PATH is the path to the required file storage_volumes
relative to storage volume, which can be found in the  detail dialog.Call 

Example: http://localhost:8080/CallRecorder/Storage/1/2012/06/20/22/2012-06-20_22-07-47_81267_8666685394-1.rtp

The storage web URL is protected by a password which is random by default but can be configured from the Storage > Advanced > Player 
Access Password. The user name is "player".

If you need to, you may construct and send HTTP Basic Authorization Header yourself. To do this you need to perform the following steps:
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1.  

2.  

Build a string of the form  , e.g. "player:123"username:password
Base64 encode the string, e.g. "cGxheWVyOjEyMw=="
Supply an "Authorization" header with content "Basic " followed by the encoded string, e.g. "Basic cGxheWVyOjEyMw==" so the header 
will look like "Authorization: Basic cGxheWVyOjEyMw==".

Note:  HTTP error code 401 is sent when the password is missing or incorrect, letting the browser prompt you for user/password. User name is 
'player'.

 

6. Transcoding URL

Searches the call in the database, then transcode it to the desired output format, and send a redirect response to the temporary URL. If there is 
more than one call matching the query, the first one is used.

Parameters below are optional, that is searches can be made using any subset of parameters, so there is no longer any need to connect directly 
to the CallReplay database:

http://host:port/CallRecorder/Transcoder?callId=GUID&wireCallId=x
 &beginTime= .ss&endTime= .ssyyyy.mm.dd-hh.mm yyyy.mm.dd-hh.mm
 &callerIP=x&callerPort=x&callerMAC=x&callerNumber=x&callerName=x
 &calledIP=x&calledPort=x&calledMAC=x&calledNumber=x&calledName=x
 &format=x&password=x&lang=x

Parameters:

Format:
spx or wav - redirects to audio files; when multiple callIds were requested, their audio files are concatenated and the response 
redirects to the resulted file
png - redirects to a .png image of audio file
json - returns a list of details for all calls matching the query, in json format

beginTime and endTime - calls will be searched for start time between these values (if provided).
pbxCallId is the SKINNY call ID or SIP call ID
callId is the database call GUID; multiple callIds may be requested
numbers and names  are searched for text   provided valuescontaining
IPs, ports and MACs are searched for exact match
password is the password set in Storage > Advanced > Player Access Password. Instead of using this parameter, you can send a HTTP 
Basic Authorization Header instead.
lang - one of the 2 char language identifier supported by CallReplay (see login dialog in administration site); used to display error 
messages; can be omitted for english

Notes:

if the requested format is the same as storage format (see Storage > Advanced), you will receive a redirect to a File Storage URL for the 
file to be delivered straight from the storage. You need to supply a HTTP Basic Authorization Header in order to successfully download 
the file, as described in paragraph 5 File Storage URL.
since the same user/password is used for Transcoding URL and File Storage URL, you may prefer sending HTTP Basic Authorization 
Header to the Transcoding URL instead of 'password' parameter.
HTTP error code 401 is sent when the password is missing or incorrect, letting the browser prompt you for user/password. User name is 
'player'.
HTTP error code 412 is sent when other errors occur, along with an error message.

 

7. External Replication API

Downloads call details using HTTP requests.

Prerequsites: 

To use this feature, you must add a replication branch and configure it for Replication API. This means go to the HQ/Branch Replication page, 
then to the Branch tab, where you add a new HQ. That is, add here the IP address of the computer from which you want to download calls.
This is necessary for two reasons:

CallReplay has to maintain a replication queue for this HQ like it does for all HQ-s. This is, in fact, a real HQ, more precisely, a 3rd party 
HQ (a computer where the calls will finally arrive).
This allows you to have multiple 3rd party HQ-s as well as CallReplay HQ-s.

http://usernamepassword/
http://hostport/
http://yyyy.mm.dd-hh.mm
http://yyyy.mm.dd-hh.mm


URL Format:

http://HOST:PORT/CallRecorder/Replicator?lang=x&tenant=x&replicationQueueName=x&password=x&lastReplicationId=x&deletePrevious=<true
 /false>&chunkSize=x

Parameters:

tenant - the tenant id from which to download call details; can be omitted for default tenant
replicationQueueName - must contain the exact HQ name (case sensitive) or the IP address entered for this HQ; it may be anything, 
even a fake IP - it is used just to find the queue with the not-replicated calls for this HQ.
lastReplicationId - the last confirmed replication id - first time should be 0, the subsequent invocations should contain the last received 
replication id in order to be deleted from the database and advance to next operations; these IDs are in ascending order, but not 
necessarily contiguous;
chunkSize - how many operations to return; can be omitted for default which currently is 50
deletePrevious - whether to delete the row with lastReplicationId or not; when false, it will be retrieved again and again until deleted
password - connection password set in the HQ dialog. Please configure CallReplay server to use HTTPS in order to hide the clear text 
password from a network analyzer. Instead of using this parameter, you can send a HTTP Basic Authorization Header, similar to the one 
in paragraph 5 File Storage URL. The user name is "replicator".
lang - one of the 2 char language identifier supported by CallReplay (see login dialog in administration site); used to display error 
messages; can be omitted for english

Response for new call:

http://HOST:PORT/CallRecorder/Replicator?...&lastReplicationId=5

< s>CallRecording

 

 <!-- sample respone for a Cisco SIP call -->

<CallRecording>
<ReplicationId>3711</ReplicationId>
<Action>Create</Action>
<origLegcallIdentifier>17083749</origLegcallIdentifier>
<destLegIdentifier>17083750</destLegIdentifier>
<origLegSipCallId>0017e014-1e45000b-9d89d8c8-883d5c8c@10.1.0.61</origLegSipCallId>
<destLegSipCallId>38fe6b00-44510457-27e-6900010a@10.1.0.105</destLegSipCallId>
<globalCallID_callId>8062</globalCallID_callId>
<globalCallID_callManagerId>1</globalCallID_callManagerId>
<CallRecordingId>95a21ee8-adb5-2d5e-c208-6727e663e65f</CallRecordingId>
<StartTime>2014-10-22 16:35:36.746 +0300</StartTime>
 <DurationMS>7300</DurationMS>
 </CallRecording>

 

<!-- sample respone is for a Cisco SCCP call -->

 <CallRecording>
<ReplicationId>3721</ReplicationId>
<Action>Create</Action>
<origLegcallIdentifier>17083687</origLegcallIdentifier>
<destLegIdentifier>17083688</destLegIdentifier>
<origLegSipCallId/>
<destLegSipCallId/>
<globalCallID_callId/>
<globalCallID_callManagerId/>
<CallRecordingId>3a07f1fb-9dd5-c60f-c2fc-5b14a3597a50</CallRecordingId>
<StartTime>2014-10-22 16:41:30.146 +0300</StartTime>
<DurationMS>6000</DurationMS>
</CallRecording>

 

<!-- sample response for a deleted call --> 

< >CallRecording
< >24</ReplicationId ReplicationId>
< >Delete</ >Action Action

http://HOSTPORT
http://HOSTPORT
http://HOSTPORT


< >ed29894d-4a34-2944-b827-a76e00bd6b6a</ >CallRecordingId CallRecordingId
</ >CallRecording

</ >CallRecordings

Response when there are no more operations at this moment:

http://HOST:PORT/CallRecorder/Replicator?...&lastReplicationId=654

<CallRecordings>

</CallRecordings>

Response in case of error: 

<Error>

<Code>errorCode</Code>

<Message>error message</Message>

</Error>

Possible error codes:

1 - unknown error

2 - 'replicationQueueName' parameter was not set

3 - password parameter is missing or the password is wrong

4 - specified replication queue name was not found

5 - specified replication queue name was not configured for replication API - please go to HQ/Branch Replication page, edit HQ and check 'Only 
for Replication API'.

Notes:

HTTP error code 401 is sent when the password is missing or incorrect, letting the browser prompt you for user/password.  User name is 
'replicator'.
HTTP error code 412 is sent when other errors occur, along with an error message.
Error messages will be returned in the chosen supported language (default is English).

Deleting Calls

The Replicaton API can also be used to delete calls. You will need to follow the steps from the  section of the Prerequsites External Replication 
.API

URL Format:

http://HOST:PORT/CallRecorder/Replicator?command=delete&callGuid=x&replicationQueueName=y&recursive=true

Parameters:

command - use the value 'delete' to delete calls

http://HOSTPORT


1.  

2.  

replicationQueueName - must contain the exact HQ name (case sensitive) or the IP address entered for this HQ; it may be anything, 
even a fake IP - it is used just to find the queue with the not-replicated calls for this HQ.
callGuid - the GUID(Globally Unique Identifier) of the call to delete
recursive - if true, the call will be deleted from any replication branches it is found on. The default value is false.
password - connection password set in the HQ dialog. Please configure CallReplay server to use HTTPS in order to hide the clear text 
password from a network analyzer. Instead of using this parameter, you can send a HTTP Basic Authorization Header, similar to the one 
in paragraph 5 File Storage URL. The user name is "replicator".

Response in case of successfully deleting a call (non-recursively):

http://HOST:PORT/CallRecorder/Replicator?command= &replicationQueueName= & =PWD&callGdelete Replication password
uid= d0b6426-ceaa- - - d25f25dccfa7 9012 4106 2

<?  =  =  = ?>xml version "1.0" encoding "UTF-8" standalone "no"
<CallRecording>
    <LocalServerStatus>   .</LocalServerStatus>Call not found
    <LocalServerMessage>   .</LocalServerMessage>Call not found
    < >   .</ >Status Call not found Status
    < > </ >Action Delete Action
    <CallRecordingId> d0b6426-ceaa- - - d25f25dccfa</CallRecordingId>7 9012 4106 2
    <Servers/>
</CallRecording>

Response in case the call doesn't exist or has already been deleted (non-recursively):

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
< >CallRecording
    Call not found.< >LocalServerStatus </ >LocalServerStatus
    Call not found.< >LocalServerMessage </ >LocalServerMessage
    Call not found.< >Status </ >Status
    Delete< >Action </ >Action
    7d0b6426-ceaa-9012-4106-2d25f25dccfa< >CallRecordingId </ >CallRecordingId
    < />Servers
</ >CallRecording

Response in case the call exists on the main serve ) nd on two other replication branches 10.1.0.117 and 10.1.0.113) r (10.1.0.131 a (
(recursively):

http://10.1.0.131:80/CallRecorder/Replicator?
command=delete&replicationQueueName=Replication&password=PWD&callGuid=835f6c9a-bca9-8b82-05e6-
76b1d9b2a7d9&recursive=true

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
< >CallRecording
    Success< >LocalServerStatus </ >LocalServerStatus
    Success< >LocalServerMessage </ >LocalServerMessage
    Success< >Status </ >Status
    Delete< >Action </ >Action
    835f6c9a-bca9-8b82-05e6-76b1d9b2a7d9< >CallRecordingId </ >CallRecordingId
    < >Servers
        < >ServerStatus
            Success< >Status </ >Status
            10.1.0.117:80< >IpPort </ >IpPort
            Success< >Msg </ >Msg
        </ >ServerStatus
        < >ServerStatus
            Success< >Status </ >Status
            10.1.0.113:80< >IpPort </ >IpPort
            Success< >Msg </ >Msg
        </ >ServerStatus
    </ >Servers
</ >CallRecording

CallReplay Cloud Server

Introduction

The Cloud Server is a feature of CallReplay which allows you to record calls and upload them on a properly configured CallReplay Cloud Server.

The Cloud Server can be used as a Replication HQ for other CallReplay servers or mobile recorders.

You can make use of this feature in two ways: 

Uploading to the public CallReplay Cloud Server located at  ;http://cloud.call-replay.com

http://cloud.call-replay.com/


2.  Configure your own CallReplay Cloud Server - this way you have all features of CallReplay Call Recorder.

Supported mobile phones: Android 2.3.3 or higher; other operating systems may be supported in the future.

Configuring your own CallReplay Cloud Server

First of all, you should acquire a license for this. The license should contain how many tenants you need (i.e. cloud accounts) and how many 
phones and mobiles you want to record   upload calls.and

Upload this license in your CallReplay installation using System -> Licensing.

Add Tenants 

then go to System -> Tenants page. You can add your tenants here.

 System > Tenants

 

First enter the company name and fill the TLD field with your domain name / website if any.

You can assign a number of Replication Branches, if you want to make this tenant a Replication HQ. In this case, you should allocate a number 
of channels to those branches and assign them individually from HQ/Branch Licensing  page. That is, if you want branches A, B and C to upload 
calls to this tenant, write 3 in 'Branch' edit box. Then, if you want A to have 5 channels, B and C have 10, write 25 in 'Channels' edit box, then 
later go to HQ/Branch Licensing and assign each of them the corresponding channel number. Here you will introduce the total number of 
channels allocated to the group of branches associated with this tenant.

In 'Mobile Phones' you will write the total number of mobile phones that can upload calls to this tenant (cloud account).

'Storage Quota' - how much of storage space will be allocated to this tenant from the total storage pool. Older records will be deleted when the 
quota is reached. Enter 0 if you want to use global cleaning.

'Active' - use this checkbox to activate / deactivate the tenant.

'Validity' - if you want to automatically deactivate the tenant after a period of time.

After pressing 'OK' button, a new tenant will be generated and you can see it in the main list. There you can find the generated Tenant ID used 
for tenant identification.

Add Tenant Admin

You may create multiple user accounts for each tenant, at least one of them should have administrative rights. You can quickly create such an 
administrative account using 'Add Admin' button from 'Tenants' page.

A password will be randomly generated for the tenant administrator and it will be sent to the specified e-mail address.

Public Tenant Creation

This feature is available only on public CallReplay Cloud Server located at   Anybody can create a trial tenant for itself. http://cloud.call-replay.com.
This trial tenant will expire after 1 month and its storage quota is limited to 200MB.

To convert a trial tenant to a permanent tentant, please contact sales or support.

Tenant Login

Upon creation of the its account, the administrator will receive an e-mail containing the login credentials. In order to access the Cloud Server, the 
administrator (and users created subsequently) must enter the Tenant ID along with the login name and password.

After login, you have access to all recorded and uploaded calls. You can playback them (if not encrypted), e-mail them and so on.

Localization

Requirements

For creating a custom localization of CallRecorder you need at least version 7.1.10 of application installed using a full setup.

Creating/editing CallReplay localization

CallReplay CallRecoder has two major components who need to be translated separately. One component is recorder service and other is site 
administration.
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First thing which must be done is to create a copy of entire   folder into CallReplay data folder.   folder can be found in Translations Translations
installation path, usually c:\Program Files\CallReplay\System\Translations. Data folder is the folder where the database is kept, default value is C:
\CallReplay.

Once we have new   folder we can start to create/edit translations. All customizations must be done in this new   folder Translations Translations
otherwise will be lost after first running of CallReplay Software Update or after a full setup.

The tools used for translation are " "  and " ".translate_site.cmd translate_server.cmd

Create a new translation for CallRecorder site

Go to the new   folder created using indications from previous paragraph.Translations

Duble-click on " " file. If this is the first time when the translation tool is used you must select a language for translation tool translate_site.cmd
interface:

After language selection the main window of translation tools is shown:

 Press the add language button:

Select desired language from the list:

The result is a new Language node:

Now select the new language and translate every key from the master file to the new language. Next picture show how to do translate "All rights 
are reserved" to Korean.

The untranslated keys are shown with blue color. So it is easy to know which keys are translated and which not.

For saving the new language press "CTRL+S" which is a shortcut for File>Save option and a new file having name  will be  "site_xx.properties"
created where   is the language code.xx

Create a new localization for CallRecorder service

Go to new   folder and double-click on " ". The same tool as for translating site will be shown excepting that the Translations translate_server.cmd
keys are for CallRecorder service.

Create a new localization for CallRecoder service following the same steps as for CallRecorder site. The name of the new translation will be "serv
" where   is the language code.er_xx.properties xx

Activate a new localization

A new localization becomes active after including in file " " the line:  and restarting of CallRecorder service.locale.properties xx=Language 

e.g.: ko=

Editing an existing localization for CallRecorder site and service

Run the translation tool ( " " for site and " " for service ), select the language and edit the keys accordingly. translate_site.cmd translate_server.cmd
Save the changes ( CTRL+S or File > Save ).

Download Files from Our FTP Server

You can download releases from our FTP server, which is located at , using the following credentials:this address
 

 anonymousUser:
 anonymousPass:

 
Our FTP server can use the passive mode for data transfer on ports in the range of 50000-51000, or active mode on port 20, so make sure to 
allow connections on those ports in your firewall.
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In order to download installation setup kits from our FTP server, you can use a web browser such as Firefox or Google Chrome (but not Internet 
Explorer), or a FTP client such as  or .WinSCP FileZilla
 
Use no encryption when connecting to the server.
 
Below is a screenshot showing how to configure WinSCP. In this case, the Passive mode is used, so ports in the range of 50000-51000 will be 
used. If you uncheck the passive mode, then port 20 will be used in Active mode.
 

 
Once logged in, you may proceed downloading the file of your choice:
 

 
Note that if you are using a web browser and point it to  , then passive mode will be used by default.ftp://ftp.call-replay.com/

Upload Files Manually to Our FTP Server

To upload logs manually to our FTP server, first you need to locate the log files which correspond to the time when the issue occurred, archive 
them using a program such as 7-Zip, and then upload them to the FTP server using the credentials shown below. Please notice that it helps us if 
you set the  to  inside the  menu before the issue occurs, so that additional Tracing Priority All CallReplay -> Help -> Service Debug Settings
information gets included in the log. Also, the most important logs are the ones ending in the  extension, so make sure to include them as well..trx
 
By default, the log files can be found in the following location:
 
On Windows: C:\CallReplay\Logs
On Linux: /var/lib/callreplay
 
The FTP credentials are:
 
Server: ftp.call-replay.com
User: support@call-replay.com
Pass: support123
 
Please make sure that the FTP client settings are set on  (not SFTP), using .FTP no encryption
 
To upload the archive, you can use a FTP client such as , available on both Windows and Linux, which can be downloaded from , or FileZilla here

, available on Windows only, which can be downloaded from .WinSCP here
 
Keep in mind that for the Passive Mode, ports 50000 through 51000 have to be open in the firewall. For the Active Mode, port 20 is used for data 
transfer.
 
Please tell us in an email message the name of the file that you uploaded.
 
Below is a screenshot showing how to connect using WinSCP:
 

 
If connecting using Filezilla doesn't work, try going to  and set the  to .Edit->Settings->FTP Transfer Mode Active

Send Logs

AI Software is dedicated to its customer and willing to deliver best user and business experience through the products and services. Therefore, C
 comes with a convenient and easy to use problem reporting coponent that you can use to report, manually or automatically, when allReply

something is not working.

Before using this feature it is important to provide contact information that will help  support people to connect with you.RAI Software

To configure contact information:

Go to .Help > Send Logs
Provide a name for the contact and that will be used for communication
Introduce the prefered e-mail address to be used in connection with  problemCallReplay
Introduce the preferend telephone number
Click .Save

https://winscp.net/eng/download.php
https://filezilla-project.org/
ftp://ftp.call-replay.com/
http://ftp.call-replay.com
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https://winscp.net/eng/download.php


1.  
2.  
3.  
4.  

1.  

2.  

To report a problem manually:

Go to .Help > Send Logs
Select  tabManaual Reporting
Introduce requested information
Click  Report.Submit

Problem description:
When the problem appeared:
Filter log files:
Include detabase backup:
Sending option:

Giving more detail int he description helps us to determine cause of a problem much faster. Reporting issues when they happen 
helps make CallReplay better, and we appreciate the time it takes to give us this information

To report problem automatically:

Go to .Help > Send Logs



2.  
3.  
4.  

1.  
2.  
3.  
4.  

1.  
2.  
3.  
4.  

Select  tabAutomatice Reporting
Check .Automatic Upload Enabled
Introduce requested information.

 

By default CallReplay provides a precofigured FTP connection, but you can configure custome ones according with your needs or as per support 
people recommendation.

To add FTP connection:

Go to .Help > Send Logs
Select  tabAutomatice Reporting
Click .Add
Introduce requested information.

To delete FTP connection:

Go to .Help > Send Logs
Select  tabAutomatice Reporting
Check the row(s) containing the FTP connection(s) you want to remove.
Click .Delete

Adding new Phone Services

Adding new Phone Services

    1. Customizing the Phone Services

 The default CallReplay Phone Service will display a menu where different functions can be selected. However, you can customize the Phone 
Service URL so that you can access a specific function with a push of a button. The different functions and their URL's are displayed in Table 1. 
  
Table 1

Service Description URL

Main Service Provides users with a menu with extensions http://x.x.x.x:80/CallRecorder/phoneService?
name=#DEVICENAME#

http://x.x.x.x:80/CallRecorder/phoneService?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService?name=#DEVICENAME#


Recordings Listen to audio recordings, according to 
user's access rights

http://x.x.x.x:80/CallRecorder/phoneService
/replayPhoneListOfExtensions?
name=#DEVICENAME#

Monitoring Listen to live calls, according to user's 
access rights

http://x.x.x.x:80/CallRecorder/phoneService
/monitoringPhoneListOfExtensions?
name=#DEVICENAME#

Record this call Demands recording of current call http://x.x.x.x:80/CallRecorder/phoneService
/onDemandPhoneDemandThisCall?
name=#DEVICENAME#

Pause this call Pauses the recording of current call http://x.x.x.x:80/CallRecorder/phoneService
/recordPause?name=#DEVICENAME#

  
  
 

    2. Adding a new Phone Service

Log in Cisco Unified CM Administration, then go to Device -> Device Settings -> Phone Services and add a new service 
 

 
 
Enter the new name of the service and the URL (which can be found in Table 1) and then check Enable
 

 
 

    3. Subscribe your phone to the new service

In the Phone Configuration window, select Subscribe/Unsubscribe Services and click go, then select the new service in the pop-up window, click 
next and subscribe. 
 

 
 
 

    4. Add the Service to a softkey button

On the right-hand side, look for add new SURL, click it and add the new service. Attention: if the Add new SURL is in the Unassigned Associated 
Items list, you will need to create a custom Phone Button Template, to add 
the service URL to one of your available softkeys (see section 5). 
  
 

 
 

    5. Creating a new Phone Button Template

If you need to assign Service URL to softkeys, you will need to create a new Phone Button Template. Go to Device -> Device Settings -> Phone 
Button templates, find the one you are using for your phone, select it, 
press copy and set a new name for it. 
 

 
Search for the new template, select it, and configure the softkeys you wish with the Service URL option.
 
 

 
Finally, go back to the phone's configuration, select the new button template and apply the new configuration.

http://x.x.x.x:80/CallRecorder/phoneService/replayPhoneListOfExtensions?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService/replayPhoneListOfExtensions?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService/replayPhoneListOfExtensions?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService/monitoringPhoneListOfExtensions?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService/monitoringPhoneListOfExtensions?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService/monitoringPhoneListOfExtensions?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService/onDemandPhoneDemandThisCall?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService/onDemandPhoneDemandThisCall?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService/onDemandPhoneDemandThisCall?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService/recordPause?name=#DEVICENAME#
http://x.x.x.x:80/CallRecorder/phoneService/recordPause?name=#DEVICENAME#


Enable SSL for Web Interface

To enable logging in via HTTPS instead of plain HTTP, use the System->HTTPS menu entry.
 
I. Generate a Self-Signed Certificate
 
This can be accomplished by following the steps shown in the screenshots below:
 
  
1. Choose "Secure" as the Connection Type:

 System > HTTPS

2. Press Finish once the "Generate Self-Signed Certificate" radio button is checked:



3. Restart the service:

II. Import a PFX/P12 Certificate
 
1. Select "Import Certificate":

2. Click on "Browse" and select the pfx/p12 certificate from the popup browser. You may need to enter a password for the certificate as well:

3. Click Next and then Finish. Once done restart the service:

Editing Protocol Settings in PBXs

By default, the three protocols listed in a Cisco CallManager PBX are Skinny, SIP and Forked Recording, which come with default settings to 
record enabled. However, each of these protocols can be configured further by clicking the Edit button on the respective protocol.

Recording > CallManager (PBXs) > Edit PBX



Edit Cisco Skinny

Recording > CallManager (PBXs) > Edit PBX > Edit Protocol

Version: Protocol version, depends on the Skinny versions supported by the firmware of the phones, the default (8.0) should work for most 
phones.

Port: The Skinny port used by the phones to communicate with CallManager.

Disable This Protocol: Check this if you want to disable this protocol for this PBX.

Deny: Ignore calls and do not record calls using this protocol for this PBX.

Edit SIP

Recording > CallManager (PBXs) > Edit PBX > Edit Protocol



Port: The SIP port used by the phones to communicate with CallManager.

Disable This Protocol: Check this if you want to disable this protocol for this PBX.

Deny: Ignore calls and do not record calls using this protocol for this PBX.

Edit Cisco Forked Recording

Recording > CallManager (PBXs) > Edit PBX > Edit Protocol

Play Recording Tone: Enable this option so that users will hear a recording tone in their phones whenever the call is getting recorded.

Recorder Address: The IP of CallRecorder.

Password: The password of the CallReplay username.

Username: The username which is used for the Recording Profile.

Record Encrypted Calls: Check this to be able to record encrypted calls.

Port: The port used for SIP communication.

Disable This Protocol: Check this if you want to disable this protocol for this PBX.

Deny: Ignore calls and do not record calls using this protocol for this PBX.



Setting Up HTTPS

By default, the CallReplay web interface can be accessed via plain HTTP, however SSL can be enabled from the  menu. This System > HTTPS
will allow users to log in to CallReplay securely over a HTTPS connection. The administrator can generate a new certificate or use an existing 
one.

In , under the  dropdown list, switch to :System > HTTPS Connection Type Secure

System > HTTPS

The Certificate Configurator window should appear. Here you can generate a self-signed certificate, or import an already existing certificate. You 
can also change the existing certificate and start using a different one.

Generate Self-Signed Certificate

To generate a new certificate, make sure the  radio box is checked and click . A confirmation to restart Generate Self-Signed Certificate Finish
the CallReplay service will appear.

Click Yes to restart the CallReplay service and enable the new settings.

To check the new connection type, open a web browser and go to . If the certificate is not signed by a CA authority, https://IP_OF_RECORDER/
you will most likely need to explicitely tell the browser to accept the public certificate:

Confirm the security exception. Next, the CallReplay login interface should appear. The  window should show information about System > HTTPS
the currently used certificate:

 

Import Certificate

https://IP_OF_RECORDER/
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/fx_confirm_exception.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/cert_info.png


You may want to use an already existing certificate, in which case in the Certificate Configurator window make sure the  radio Import Certificate
box is checked:

Click . In the window that appears, browse to the location of the certificate file (pfx/p12) that you want to import.Next

Click Next. A window showing available certificates will appear. Select the desired one and click Next.

Restart the CallReplay service to enable the new settings.

LDAP Authentication! High Prio (Draft)

Release Notes

v10.0 Features

v10.0 Features

Bugs are not included as this is a major release

# Subject Category

2833 Upgrade to Azul JDK11 

2070 memolith logs upgrade Memolith

2659 Classifier speedup

3145 KeyStore Editor component Security > Certificates

2901 Modern SVG icons

2891 Search by call id

3064 Computers panel missing Replay

3103 Update AXL and jtapi.jar to v12.5

2779 System > Alerts

3078 Use DB Pooled Provider

3031 Unified Configuration needs Quick Search of categories

2700 Storage > Storage Volumes Web Interface

2681 Opus codec support in Qodec and CallRecorder

2740 Playback > Active Calls

2720 System > E-mail

2942 Upgrade DB to Postgres 12

2752 Help > About

2887 Change retention default from "keep until space required"

2744 Quality > Answers

2781 Quality Module

https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/import_cert.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/browse_pfx.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/certificates.png
https://wiki2.raisoftware.ro/uploads/images/gallery/2016-09-Sep/restart.png


2788 Call Description in exported list

2857 Replay Calls Replay

2839 redo PreConfiguration in HTML using a 
temporarily started, localhost, web server

Preconfiguration

2736 Storage > Storage Settings

2701 System > Ldap Authentication Web Interface

2865 Licenses descriptors

2743 Quality > Reports

2718 System > Licenseing > Licensing Pools

2711 System > Configuration > Retention Policy

2774 Merge replication and licenses together.

2710 System > Configuration > Recording Policy

2830 Global Menu Web Interface

2689 Login page

2841 Root page

2840 Maintenance Progress page Web Interface

2729 CallReplay - ScreenRecorder > 
ScreenRecorders

ScreenRecorder

2836 Upgrade Innosetup to v6

2709 System > Configuration > Email Notification

2730 Help > Service Debug Settings Web Interface

2733 Recording > Silence Compression

2734 Recording > SPAN Troubleshooting

2735 Recording > Advanced

2745 Backup > Backup

2754 Session > Logout Admin

2831 Upgrade to Vaadin 14

2722 System > HQ / Branch Replication > Branch

2721 System > HQ / Branch Replication > Headquarters

2717 System > Licenseing > HQ / Branch Licensing > Branch

2716 System > Licenseing > HQ / Branch Licensing > Headquarters

2708 System > Configuration > Filters

2731 Recording > Network Interfaces

2748 Screen Recorder > Settings

2753 Session > Change Password

2751 Help > Browser Logs

3057 Forked Recording without JTapi (Mobile 
Jabber Recording)

Recorder > Forked > JTapi

2977 Category-Period Summary Cache Replay



2863 SSL Security Recorder > Forked > Axl

2739 Playback > Replay Calls

303 Star calls Web Interface

502 external (turret) config params Recorder > IPTrade

716 thrift client should connect using https to a 
https configured server

Replication

907 HA deduplicate calls by cisco leg identifiers High Availability

1174 Blocarea asocierii call-urilor pe noduri de 
configurare

Classifier

2161 ArrowLib Recorder

2226 UX: Research for suitable framework -> 
Score Card to make a decision

Web Interface

3033 Search bar in unified configuration Configuration

2963 URL for accessing call details specifically

2714 System > Licenseing > License > Licenses Administration > Licensing

2732 Recording > Call Managers

3164 Improve password security Security > Login

2597 Record Encrypted Calls on CUCM Recorder > Forked

3129 Verify SRTP Calls on CUCM 12.5 Recorder > Calls

2819 Error when trying to export calls

2867

VAD not working with IPTrade Recorder > IPTrade

2861 Secure LDAP method deprecated needs 
updating

Security > Ldap

2621 Update IP Trade recording Recorder > IPTrade
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Introduction-

Product Overview
Features and Benefits
Dashboard- DEPRECATED
User login

Product Overview

CallRecorder is an easy to use VOIP call recording solution that implements the corporate call recording keeping policy and provides secure and 
easy access to call records.

It allows managers to review and score phone calls according to their work group.

Users are empowered by providing them with accurate records of their calls.

https://todo.raisoftware.ro/redmine/issues/3164
https://todo.raisoftware.ro/redmine/issues/3164
https://todo.raisoftware.ro/redmine/issues/2597
https://todo.raisoftware.ro/redmine/issues/2597
https://todo.raisoftware.ro/redmine/issues/3129
https://todo.raisoftware.ro/redmine/issues/3129


CallRecorder is a self-contained software recorder which includes everything necessary to record VoIP calls (besides the Operating System and 
server hardware): database, web server, Java, etc.

Memolith Screen Recorder integrations allows the recording of computer desktops, either linked to a phone call or non-stop.

Features and Benefits

Automatically Record Phone Calls - Damage control and increased accountability in your personnel, suppliers and customers.
Manual (On-Demand) Control: recording can also be initiated by the user using the browser or IP Phone Service. Both
Full Call and Partial Call recording modes are supported.
Multiple Recording Methods: CallRecorder supports both port mirroring (SPAN) and forked recording (SPANless).
Hardware recording coming soon!
Monitor live calls: Listen to a call in progress, through the browser or IP phone service. You can also whisper to the agent without being 
heard by the external party (IP phone service).
Browse Recordings by Agent - Superb browsing interface tracks agents across multiple phone numbers.
Search by caller ids, phone numbers, annotations, time, description, tags, etc.
Replay, Annotate and e-Mail phone call recordings. Easy, secure access to call recordings, using a web audio player, desktop audio 
player or IP Phone Service.
Tagging & Searching calls with customized hierarchical tags has never been easier.
Call Scoring & Custom Forms - Integrated agent scoring and reporting module
Agent Call Statistics Reports: the number of calls made, received, etc by each agent
Email Notifications: automatically send email when a predefined number appears in a call.
Backup & Restore: Archive calls on DVDs, HD-DVDs, BluRays or SANs. A single DVD can store up to 15,000 calls of 5 minutes each, 
due to the state-of-the-art voice compression technology incorporated in CallRecorder.
Reverse Caller Lookup - Displays the caller name and business unit using the company Phone Directory.
Multi Site Replication: using queued replication, you can record many network partitions and centralize recordings at the HQ. Recording 
and replication survive a downed WAN link.
Screen Recording – Integration with Memolith Screen Recorder. See what was done on the screen while the phone call occurred.
Specialized Speech Compression lowers the storage requirements 8 times over MP3 and allows 18,000 hours of phone calls storage on 
one 120 GB hard drive.
Call History - follow a call as it is transferred, put on hold or parked
Audit Replays – prevent recordings abuse by browsing the list of accesses to a call.
XML Phone Service – handily review your past calls from your XML enabled phone (Cisco IP Phones 7940, 7960 & 7970). Authenticate, 
Browse, Play, Rewind, e-mail, mark important. You can also assign calls to folders.
Access Control Lists – fine grained permission system to allow listening and acting on calls.
Automatic Software Update - the easiest, fastest way to apply patches
Thin Client Deployment – The administration and user tools run in all web browsers supporting Flash.
Integrated Support Tools – Request & receive technical support with a few clicks, by using the integrated log packer and TeamViewer 
support tool.
Passive network sniffing assures zero impact of recording on PBX performance and improves system reliability.
Try Before You Buy – Download a fully-featured evaluation version with a friendly configuration wizard from: http://www.call-replay.com

Dashboard- DEPRECATED

The Dashboard, new in CallReplay 10, will allow displaying of various stats and settings about CallReplay in a single window. Here one can add 
various widgets such as System or Database information, monitoring of storage space or the database.

The new Dashboard:

The Dashboard also supports adding graphs for recorded calls:

User login

Login

You connect to the CallReplay web interface by opening the address supplied by your system administrator. Next, login with your user account.

http://www.call-replay.com


To change your password, go to the top right of the call replay web console and select your login name, which will then display a drop down 
menu as below

From here you may review your profile

Change your password and logout

When selecting Change Password the following screen is displayed where you can cahneg your password and also your PIN



Recordings

Replay Calls-
Video Recordings

Replay Calls-

Replay Calls is the main user page. From here you can play and search recordings and access the call details page for each recording. Video 
recordings can also be accessed from here
Introduction

From the top menu choose Replay Calls:



In the Replay Calls menu you can see by default all calls recorded today. They can be found in the All folder on the left and distributed among the 
users.

Note: You can only play the calls that your user account has permission to playback.

Quick Play

Next we will show you how to listen to your calls. Click on speaker icon and a new window will appear, as shown below:

From here you can Play your selected call by pressing the highlighted button.
Notice the caller ID's, first the caller then the called, the start date&time and the duration.

In addition to listening to recorded calls, if a call has an associated video recording, shown by a blue-lit film icon, you can click on it to view the 
video recording with the call's audio.

 This will open the Video Player window, which displayes the time, date and the parties involved with the associated call.



Live Monitoring

If a call is in progress it can be monitored. For this, press the speaker button and the following window is shown:

Properties of the call

Click on the details icon and choose Properties, or double-click a call. A window will appear, as shown below:

Here you can view the call/video details, view/change the call's category, set description of call or export the call to email or to disk using wav or 
speex format. 

Categories
You can assign more users/categories to a call



Editing Descriptions

In the text box enter the description you want. Then click the Save button.

Quick Save - Mailing

The options presented are Save Call or sending it by E-mail using the Wav or the Speex format.



Wav (Waveform Audio) A common audio uncompressed file format for 
Windows computers (.wav). It has the advantage of being played by 
any Microsoft Windows sound application, the disadvantage being 
that it is uncompressed, thus, very large.

Speex A free software speech codec designed for VoIP which provides 
very good quality speech and low bit rate, thus, occupying less disk 
space.

External Numbers - Customers

Phone number can be added/assigned to a customer. For this, click on exclamation mark and choose Add to Customer

You can select an existing customer or add a new one.

Advanced Search

In the Replay Calls page you can search recordings



You can add filters to the selection tool by clicking the ... button so you may customize your search.. After you finish the filter, press Refresh.

Video Recordings

From the top of the Replay Calls window you can switch between Calls and Videos.

The Videos page shows a list of all video calls made during the selected date, unlinked to any phone calls. Their file name will reflect the host PC 
that was recorded. Click on the film icon to play.

Questionnaires

Managing Questionnaires

General

A questionnaire contains questions, grouped into categories.For each question can be defined a set of predefined answers. The status of a 
questionnaire can be Active or Disabled.

The list of questionnaires is found in Quality > Quality Standards.



The following operations are available: adding, editing, deleting and cloning.

To add a questionnaire, press Add button.

To edit an existing one press Edit button.

For creating a questionnaire based on an existingone, press Clone button.



Unused questionnaires can be deleted. Press Delete button.

Quality Standard Editor

Press Add or Edit button for editing questionnaire.

This editor allows to add / edit or delete categories and questions. Press Add button to add a category or a question.



Call Evaluation

Evaluation

The questionnaires are accessible in recordings list through extended actions menu.

Replay Calls > Call Menu



1.  
2.  

The   shows the questionnaires labels with the following information:Questionnaire menu

Evaluated questionnaires have their score displayed to the right of the label ( ex: QS 1 ).
If a questionnaire has a '  answer, then it will be marked and shown as incomplete ( ex: sta ).N/A'
If a questionnaire has all '  answers, the score will not be shown and only incomplete will be displayed ( ex: QS 2 ).N/A'
For not evaluated questionnaires, only their label is shown (ex: sta (2) ).

Calculating scores

Each question can have a real  between 0 and 1 ( ex: 0.5 = 50% ). Unanswered questions have score 0.score

The question's  is a coefficient applied to the question's score. It has one the following values:importance

Ignored = 0
Low = 0.5
Medium = 1
Important = 2

Questions of type text have importance 0 ( Ignored ) by default.

When calculating the  of an evaluated questionnaire, the following algorithm is applied:total score

Sum each answered question's score multiplied by its importance
Scale the result to a value between 0 and 100% based on the maximum achievable score of the questionnaire ( sum of answered 
questions importance ).

Note that if a question has '  answer, it is ignored from evaluation's total score. It is considered as if not answered, and the total score will N/A'
scale accordingly ( for example, you can have an evaluation score of 100% if the first question is answered '1  and the second is answered ' 0' 'N/A
).

Reports

To view reports containing questionnaire scores, go to .Quality>Reports

Choose report type , period of the report, department, and quality standard.Compare Scores



To view the report press  button.View report

To export the report to an excel file, press button.Export 

Phone Services

Using the IP Phone Service

The IP Phone Service allows users and managers alike to benefit from a couple of useful functions. 
These are: Recordings, Monitoring, and Record on demand. They are all described below in the application Main Menu section.
Note: The Monitoring function in the IP Phone Service is only accessible to Managers.

Login
Here you will enter your username and 
PIN.

Services menu

After the login, you will be presented with this screen. 
1. Select the  menu.Services
2. From the  menu, select Services application name



Phone Service Menu

There are three options in the application IP Phone Service Main Menu:

Recordings It allows call playback, moving a call to a folder and email to the 
address set in the application Configuration.

Monitoring It allows monitoring of a selected phone number.

Record this call It allows Record on Demand.

Open  then select the extension you wantRecordings

In this case, the only selection you can monitor is 2002. To select another, press the  tab then enter the PIN accordingly.Other



Now you are presented with the list of calls from that extension. From here you can play move calls to application folders and E-mail them to the 
address set in application Configuration.

 

Monitoring

From the main  menu, open  and select the extension you wantapplication Monitoring



In this case, the only selection you can monitor is 2002. To select another, press the  tab then enter the PIN accordingly.Other

Next you must enter the  you want to monitorPhone Number
After you have finished your selections, you should see the window below as a confirmation

On Demand Recording



Allows an agent the recording of a call in progress. Regardless of the moment you gave the command to record, that conversation will be 
recorded entirely.

Get Help

User Manual

The user's manual can be found in the help menu.

Help > Manual > User's Guide



TeamViewer Support

(TBD)

Remote Support

Some issues might require the CallReplay support personnel to connect to your PC for a remote support session, in which case, they will request 
a remote session. You can start a remote support sessionby going to Help > Remote Screen Connect

A new tab will open, please start a session.

Enter your name here



Save and run the file that is prompted for download.

Allow the File to run, and allow the necessary permisions.
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